THE FOOD RETAIL ENVIRONMENT SURROUNDING CANADIAN SCHOOLS
AND ITS IMPACT ON OVERWEIGHT AND OBESITY

by

LAURA MARIE SELISKE

A thesis submitted to the Department of Community Health & Epidemiology
In conformity with the requirements for
the degree of Master of Science

Queen’s University
Kingston, Ontario, Canada
September, 2007

Copyright © Laura Marie Seliske, 2007
ABSTRACT

Background: The prevalence of overweight and obesity in Canadian youth has increased considerably over the past few decades. In spite of considerable efforts, individual-level behavioural modification strategies have not been successful at preventing and treating obesity in youth. Research is emerging that has shifted attention to the environmental-level determinants of obesity. There is some evidence that the number and types of food retailers in a given neighbourhood may impact obesity risk in the individuals living in that neighbourhood, but little is known about the impact of the food retail environment on Canadian youth.

Objectives: 1) To describe the food environment surrounding the school neighbourhoods of Canadian youth (grades 6 to 10), and, determine whether access to food retailers around schools differs by area-level SES. 2) To determine whether the number and type of food retailers surrounding schools is related to the overweight status of the students attending those schools. Each of these objectives was explored in a separate manuscript.

Methods: A trend test was performed to determine if exposure to food retailers varied by neighbourhood socioeconomic status (SES) for 188 schools across Canada. Logistic regression was performed using a multilevel modeling approach to determine if an association existed between exposure to food retailers and overweight and obesity in the 7,281 school-aged youth attending the 188 schools, adjusting for individual- and area-level covariates. Types of food retailers considered included: full-service restaurants, fast food restaurants, sub/sandwich shops, donut/coffee shops, convenience stores, and grocery stores.
**Results: Objective 1.** Nearly 75% of schools had at least one food retailer within 1 km of schools, and over 90% had at least one food retailer within 5 km. Exposure to the different types of food retailers within 1 km of schools did not vary significantly (p<0.05) across schools in low, moderate, and high SES neighbourhoods, with the exception of full-service restaurants. At the 5 km distance, the SES gradient was significant across all food retailer types, with low SES neighbourhoods exposed to the least number of food retailers. This effect disappeared when population density (number of retailers per 10,000 people) was considered, except for sub/sandwich shops and donut/coffee shops.

**Objective 2.** Increased exposure to all six types of food retailers in the neighbourhoods surrounding schools was associated with a decreased likelihood of overweight and obesity. At the 1 km distance, the total number of food retailers had the strongest protective effect, while individual types of food retailers had a stronger effect at the 5 km distance.

**Conclusions: Objective 1.** Most students in Canada have at least one food retailer within walking distance of their school. The food retail environment surrounding schools is not significantly impacted by the neighbourhood SES. **Objective 2.** Increased exposure to different types of food retailers in school neighbourhoods is associated with a decreased likelihood of overweight and obesity in Canadian youth. This suggests that having access to a large number and variety of food choices may facilitate healthy food choices and protect against the development of overweight and obesity.
This thesis presents the work of Laura Seliske in collaboration with her supervisors, Dr. Ian Janssen and Dr. William Pickett.

**Manuscript 1:** *Density and type of food retailers surrounding school-aged youth: variations across socioeconomic status.* The idea of using the Health Behaviour in School-Aged Children data to examine the area effects of food retailers on SES was Dr. Janssen’s. Laura Seliske developed the classification scheme for sorting the food retailers in collaboration with Dr. Janssen and collected the data on the food retailers with help from two undergraduate research assistants (Smiriti Sharma and Victoria Swan). The SES index, statistical analysis, interpretations of results and the writing of the manuscript were done by Laura Seliske, with supervision and editorial feedback provided by Dr. Janssen and Dr. Pickett.

**Manuscript 2:** *The influence of the food retail environment surrounding schools on overweight in Canadian students: a multilevel analysis.* All three authors had input into the design and methodological approaches taken in this manuscript. Laura Seliske was responsible for the statistical analysis, interpretation of the results and writing the manuscript. Dr. Janssen and Dr. Pickett provided guidance and editorial input into the creation of the manuscript.
The other components of the thesis (i.e., Introduction, Literature Review, Multilevel Modeling Chapter, General Discussion, and Appendices) were the work of Laura Seliske, who received suggestions and feedback from Drs. Janssen and Pickett.
ACKNOWLEDGEMENTS

I would like to acknowledge the hard work and dedication of my supervisors, who dedicated countless hours guiding my progress during this thesis. Their thoughtful insights and perspectives were extremely valuable and they were always available for discussion when I needed it. Without the guidance they expertly and enthusiastically provided, this thesis would not have been possible.

I would also like to acknowledge Empire Life Foundation, the Canadian Institutes of Health Research, and the Public Health Agency of Canada for providing financial support to carry out this project.

I would like to thank my epidemiology classmates for being a part of this process. It was a privilege to be a part of an exceptional group of people whose understanding and encouragement were key to making this such a positive experience. I am grateful for the time we spent together and wish you all the best in the future. I am also thankful for the outstanding support from the faculty in the department. The welcoming atmosphere they provided and genuine interest in our progress went above and beyond expectations.

Finally, I would also like extend my gratitude towards my family, whose support and encouragement were important in keeping motivated.
TABLE OF CONTENTS

Abstract ............................................................................................................................... ii
Co-authorship statement ................................................................................................. iv
Acknowledgements .......................................................................................................... vi
Table of contents .............................................................................................................. vii
List of tables ....................................................................................................................... ix
List of figures ...................................................................................................................... x
List of abbreviations ......................................................................................................... xi
Chapter 1: Introduction ..................................................................................................... 1
  1.1 General introduction ............................................................................................ 1
  1.2 Conceptual model ............................................................................................... 1
  1.3 Objectives ............................................................................................................ 3
  1.4 Anticipated results and significance .................................................................... 4
  1.5 Thesis organization and outline ......................................................................... 4
  1.6 Reference list ...................................................................................................... 5
Chapter 2: Literature review ............................................................................................. 5
  2.1 Introduction ........................................................................................................... 8
  2.2 Overweight and obesity in children and youth .................................................... 9
    2.2.1 Prevalence and trends in Canada .................................................................... 9
    2.2.2 Health consequences .................................................................................. 9
    2.2.3 Measurement .............................................................................................. 10
  2.3 Influence of neighbourhood socioeconomic status on childhood obesity .......... 12
  2.4 Influence of urban/rural status on childhood obesity ........................................ 13
  2.5 Influence of neighbourhood food retailers on obesity ...................................... 14
    2.5.1 Increased use of restaurants and out of home food sources ......................... 14
    2.5.2 Influence of food retail environment on obesity ......................................... 15
    2.5.3 Socioeconomic status and food retailers ..................................................... 17
  2.6 Influence of neighbourhood on physical activity participation and obesity ....... 19
  2.7 Summary ............................................................................................................. 19
Chapter 3: Multilevel modeling ....................................................................................... 27
3.1 Utility of multi-level modeling ................................................................. 27
3.2 What is multi-level modeling? ................................................................. 27
3.3 Advantages of multi-level modeling ....................................................... 28
3.4 Special Considerations ........................................................................... 29
Chapter 4: Manuscript 1 .............................................................................. 33
   Abstract ..................................................................................................... 34
   Introduction ............................................................................................... 36
   Methods ...................................................................................................... 37
   Results ........................................................................................................ 41
   Discussion ................................................................................................. 42
   References ............................................................................................... 47
Chapter 5: Manuscript 2 .............................................................................. 55
   Abstract ..................................................................................................... 56
   Introduction ............................................................................................... 58
   Methods ...................................................................................................... 60
   Results ........................................................................................................ 66
   Discussion ................................................................................................. 69
   References ............................................................................................... 73
Chapter 6: General Discussion .................................................................... 82
   6.1 Bridging the two manuscripts – A summary of key findings ............... 82
   6.2 Limitations of the thesis ..................................................................... 83
   6.3 Strengths of the thesis ....................................................................... 84
   6.4 Public health and policy implications .................................................. 85
   6.5 Future research directions .................................................................. 86
   6.6 References ......................................................................................... 87
Appendix A: Food retailer categories .......................................................... 88
Appendix B: Sorting food retailers ............................................................... 89
Appendix C: The relationship between exposure to food retailers and socioecnomic gradient ................................................................. 92
Appendix D: Ethics Approval ...................................................................... 93
LIST OF TABLES

Chapter 4

Table 1. Characteristics of the 188 schools in the HBSC survey ......................... 50
Table 2. Description of the food environment surrounding the 188 schools in the HBSC survey .................................................................................................. 51
Table 3. Association between area-level SES and food retailers within a 5 km radius of the 188 schools participating in the HBSC ......................................................52

Chapter 5

Table 1. Individual-level demographic characteristics of study participants ........78
Table 2. Correlation between the number of different food retailer types surrounding the 178 schools at 1 km and 5 km distances .................................................................79
Table 3. Association between exposure to different types of food retailers within 1 km of schools and overweight .................................................................80
Table 4. Association between exposure to different types of food retailers within 5 km of schools and overweight .................................................................81
LIST OF FIGURES

Chapter 3
Figure 3.1  Hypothetical Example of Simple Level 2 Variation - Constant Slopes......31
Figure 3.2  Hypothetical Example of Complex Level 2 Variation – Varying Slopes...32

Chapter 4
Figure 1  Trends in the number of food retailers within 1 km of schools by socioeconomic status.................................................................54
<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BMI</td>
<td>Body Mass Index</td>
</tr>
<tr>
<td>HBSC</td>
<td>Health Behaviour in School-aged Children</td>
</tr>
<tr>
<td>LMS</td>
<td>Lambda Mu Sigma</td>
</tr>
<tr>
<td>SES</td>
<td>Socioeconomic Status</td>
</tr>
</tbody>
</table>
CHAPTER 1: INTRODUCTION

1.1 General Introduction

The prevalence of overweight and obesity in Canadian youth has doubled over the past 3 decades, and contemporary estimates suggest that nearly one quarter of young Canadians is either overweight or obese (1). Although considerable research funding and public health resources have been devoted to childhood obesity, there has been little success in the prevention and treatment of childhood obesity through a combination of diet, physical activity, and educational interventions (2). It has been hypothesized that the lack of effective childhood obesity prevention and treatment interventions is a reflection of the fact that these interventions have focused almost entirely on changing individual behaviours while giving little or no attention to the broader ecological factors that influence these behaviours (3). Thus, research into the etiology of obesity is moving towards identifying the environmental determinants of obesity. One aspect of the environment that is hypothesized to be an important influence on a person’s adiposity is the number and type of food retailers within the neighbourhood in which they live.

1.2 Conceptual Model

The conceptual model illustrating the hypothesized relationship between the neighbourhood food retail environment and overweight and obesity is shown below:
The model above was developed with the idea that both individual- and area-level factors affect the development of overweight and obesity. It was hypothesized that access to different types of food retailers would affect levels of overweight and obesity by facilitating or inhibiting access to certain types of food. This is expected to influence dietary behaviours, which are hypothesized to affect rates of overweight and obesity. It is expected that the food environment in the Canadian population would follow trends from other countries, where neighbourhoods with a low socioeconomic status (SES) have an abundance of ‘unhealthy’ food retailers such as fast food restaurants (4, 5) and convenience stores (6), and that areas that have an abundance of these types of food retailers will have higher levels of overweight and obesity. Furthermore, urban-rural status may also affect obesity due to both the limited exposure to food retailers and the increased likelihood for those living in rural areas to be overweight or obese (1). Because
both neighbourhood SES and urban-rural status are thought to be associated with access to food retailers and overweight and obesity, they are potential confounders in the relation between analysis. Multilevel statistical modeling strategies are required to appropriately differentiate the effects of the environment (or area-level) from the individual-level determinants of overweight and obesity such as age, sex, SES, and physical activity.

The impact of the food environment on obesity has been studied in the U.S. (6-11) and elsewhere (12-14), although little is known about these relationships in Canada. Furthermore, research has focused on adult populations, and the impact of neighbourhood food retailers on obesity is poorly understood in children and youth. Two studies in the U.S. have examined the influence of the food environment on obesity in children, and both of these studies reported that no relationship exists (15, 16). However, both of these studies were conducted in young children (<6 years of age) who have limited independence in their food choices, and it is unknown as to whether these results are transferable to older youth and adolescents. Furthermore, little is known about food retailers within the school environment, and whether or not these food retailers impact obesity levels in the children attending the nearby schools.

1.3 Objectives

This thesis involves the secondary analysis of a large dataset of grade 6-10 students attending 188 schools across Canada; as well as the development and analysis of an area-level dataset on the food environment, SES, and urban-rural location of the 188 schools. The objectives of this thesis are as follows:
1.3.1 To describe the food environment surrounding the school neighbourhoods of Canadian youth, and, determine whether access to food retailers around schools differs by area-level SES.

1.3.2 To determine whether the number and type of food retailers surrounding schools is related to the overweight status of the students attending those schools.

1.4 Anticipated Results and Significance

It is anticipated that the findings of this study will provide an understanding of the food retail environment surrounding Canadian schools and whether or not the food retail environment of schools differs by neighbourhood SES. Furthermore, the findings of this study will provide insight into whether or not the food environment surrounding schools influences overweight and obesity in Canadian youth. These results have the potential to inform policies such as zoning bylaws and quotas regarding various types of food retailers at both the school level as well as the municipal level.

1.5 Thesis Organization and Outline

This thesis is organized according to the guidelines for the *Manuscript Forms of Theses* set forth by the School of Graduate Studies and Research at Queen’s University and the Department of Community Health and Epidemiology. The next chapter of this thesis provides a literature review of the exposure and outcome variables in this study. It will be followed by a short chapter describing the methodology of multilevel modeling. This is a useful analytical strategy for determining the effect of area-level variables, such
as the food retailer environment, on individual level outcomes, such as obesity. The fourth chapter of this thesis is the first manuscript and is entitled: *Density and type of food retailers surrounding school-aged youth: variations across socioeconomic status*. The second manuscript is contained in chapter 5 and is entitled: *The influence of the food retail environment surrounding schools on overweight in Canadian students: a multilevel analysis*. Finally, Chapter 6 provides a general discussion of the thesis, including a summary of the key findings and their implications, the strengths and limitations of the research, and future research directions in the topic area.

### 1.6 Reference List


CHAPTER 2: LITERATURE REVIEW

2.1 Introduction

The prevalence of overweight and obesity among youth is increasing rapidly and is cause for concern because of the many associated health risks. Furthermore, obesity tends to persist into adulthood, making early intervention a key approach to reducing the burden of disease. Due to the lack of successful behavioural interventions addressing unhealthy weights in youth through diet and physical activity, researchers have shifted their focus to area-level determinants of obesity, which includes the structure of the physical environment in which people live. One aspect of the environment that is beginning to receive research attention is the availability of food retailers within neighbourhoods and its effects on overweight and obesity. Much of the research in this topic to date has been conducted in the U.S. and in adult population groups (1-5) and little attention has been given to the impact of the presence and types of food retailers among youth in Canada.

The objective of this literature review is to outline the problem of obesity in Canadian youth, and to describe the characteristics of the food environment that may be contributing to area-level differences in obesity rates. The final section of this literature review will be to examine possible mechanisms underlying the area-level differences. These include the influence of number and types of food retailers and their effects on obesity in various settings. Finally, this section will conclude with an outline of the limitations in current knowledge regarding children and youth. The literature review will be followed by a short chapter outlining the utility of multi-level modeling in explaining area-level effects on obesity.
2.2 Overweight and Obesity in Children and Youth

2.2.1 Prevalence and Trends in Canada

There is growing concern about the increasing prevalence of overweight and obesity among children and adolescents. In 2004, Statistics Canada reported that 8% of Canadian children aged 2 to 17 were obese with an additional 18% being overweight, for a combined ‘at risk’ prevalence of 26%. This translates to over 1.5 million Canadian children being overweight or obese (6). The prevalence of obesity has increased substantially over the past 3 decades, with a tripling of obesity rates and a doubling of the combined prevalence of overweight and obesity among youth aged 12-17 years. Regional variations across Canada also exist, with the Maritime provinces having the highest rates of overweight and obesity and western provinces having the lowest (7). In a cross-national comparison of the prevalence of overweight and obesity in Europe and North America, Canada ranked fifth highest out of 34 countries (8). It is evident, therefore, that overweight and obesity in youth is a growing public health issue in Canada that requires substantive prevention and treatment efforts.

2.2.2 Health Consequences

The rising rates of overweight and obesity in youth are of particular concern because of the associated health risks. Although several of the chronic diseases caused by obesity are not observed until mid to late adulthood, many health consequences of obesity are also observed at young ages. The metabolic syndrome, a clustering of key cardiovascular risk factors, is more prevalent in overweight and obese children (9). This is problematic because youth who have metabolic syndrome have a substantially
increased risk of developing premature cardiovascular disease (10, 11). Obese youth are also at risk for other health problems such as orthopedic complications (12) and sleep apnea (13). In addition to their physical consequences, overweight and obesity has also been associated with social consequences, such as depression (14) and social marginalization (15). Youth who are depressed often have more difficulty becoming accepted by their peers, which may lead to feelings of isolation, poor self-esteem, and other negative psychosocial outcomes.

Previous research has also consistently demonstrated the tendency for overweight and obesity to track into adulthood. For overweight 12 to 17 year olds, the probability of becoming overweight adults ranged from 63% to 84% among males and 60% to 80% for females (16, 17), with a higher probability for older adolescents. Similar results were found in a study by Whitaker et al. (18), where over two thirds of overweight youth aged 10 to 17 years remained so in adulthood, while only 10% of youth with a healthy body weight developed obesity in the early adult years. It is worth noting that the studies outlined above took place when the magnitude of the obesity epidemic was not as large as it currently is. Thus, given that the prevalence of adult obesity has also increased sharply in recent years(19), the tracking of childhood and adolescent obesity into the adult years is likely stronger than it was a generation ago.

2.2.3 Measurement

In clinical settings and epidemiological studies of large populations, it is not feasible to use sophisticated laboratory techniques to measure adiposity and obesity status. Therefore, measurements that are easily obtainable, such as height and weight, are employed. The body mass index (BMI) is a measure of weight adjusted for height
(kg/m²) that has been recommended for use in pediatric population groups by many expert committees (20-22). In adults, BMI thresholds of 25 kg/m² and 30 kg/m² are used to define overweight and obesity, respectively, at all ages. Conversely, the BMI thresholds for children and youth need to take into account differences in development by age and by sex. Commonly used BMI thresholds for children and youth are those developed by the International Obesity Task Force (23). These values were calculated for children aged 2 to 18 years that correspond to BMI cut off values of 25 kg/m² and 30 kg/m², which were then transformed to obtain the corresponding values for children and youth. This was done using the Lambda Mu Sigma (LMS) growth modeling of survey data (23) containing heights and weights from nationally representative data from several countries including: Brazil, Great Britain, Hong Kong, Netherlands, Singapore and the United States. The figure below shows the threshold values corresponding to values of 25 kg/m² and 30 kg/m², which are used to define overweight and obesity, respectively, in youth aged 2-18 years. For example, a 13 year old male would be defined as overweight if he had a BMI of 21.9 and obese if he had a BMI of 22.6.
2.3 Influence of Neighbourhood Socioeconomic Status on Childhood Obesity

Area-level differences in health status have been a focus of research within the Canadian population. Neighbourhood level socioeconomic factors may be indicators of overall socioeconomic well-being of a community that surpass individual-level effects in influencing health outcomes. Thus, neighbourhoods which are disadvantaged are likely to be at a consistent disadvantage with respect to overweight and obesity.

A consistent relationship between area-level SES and weight status has been found in Canadian youth. In their study using data from the Canadian National Longitudinal Survey of Children and Youth, Oliver and Hayes (24) found a relationship between SES and obesity for youth ages 5-17 years. They gathered information on employment, household income, and education levels for the Census Dissemination Area for students participating in the study. Census variables for the SES components were ranked and added to obtain a composite score, which was then transformed to obtain SES quartiles. Youth living in neighbourhoods in the lowest SES quartile were more likely to be overweight compared to those living in neighbourhoods in the highest SES quartile (Odds Ratio = 1.29, 95% confidence intervals = 1.14-1.46), after adjusting for individual factors (age, gender, family income, education). Veugelers and Fitzgerald (25) obtained similar findings in a large sample (N = 4,298) of grade 5 students in Nova Scotia. The home address for each participant was obtained and the median income was used to divide neighbourhood SES into tertiles. After controlling for various individual and family level characteristics, youth living in neighbourhoods in the highest SES tertile were half as likely to be obese (OR = 0.50, 95% CI = 0.36-0.70) compared to youth living in the lowest SES tertile. Finally, in a cross-national survey of Canadian youth aged 11-16 years, Janssen et al. (5) found a consistent inverse relationship between area-level SES
measures (comprised of unemployment, education, and income levels) and obesity, after controlling for individual-level covariates.

Thus, it is clear that there are neighbourhood SES effects on overweight and obesity in Canadian children and youth exist, and that these area-level effects persist after controlling for individual and family level SES covariates. However, less is known about the mechanisms through which the neighbourhood environment affects overweight and obesity. In a study of grocery stores in Seattle, Drenowski and Spector (26) found that foods which are the most energy dense cost the least amount of money. They hypothesized that the consumption of these energy dense foods is a strategy by which the poor maximize their food budgets. A possible mechanism by which neighbourhood differences in overweight and obesity arise in youth may involve energy dense foods being more available in low SES neighbourhoods. The influence of neighbourhood food retailers on obesity is discussed in more detail in section 2.5.2.

2.4 Influence of Urban/Rural Status on Childhood Obesity

Geographical measures have also been associated with overweight and obesity in Canadian youth. In their study of youth from Ontario and Alberta, Plotnikoff et al. (27) made comparisons of various health outcomes between urban and rural high school students. Schools were defined as urban if they were located in metropolitan areas with a population of more than 100,000 people. Rural schools were defined as being located outside metropolitan centres and having a population of 10,000 or less. The prevalence of overweight among boys was found to be higher in rural schools (17.6% vs. 12.4%), while the prevalence of obesity among girls was found to be higher in rural youth (4.8% vs.
2.3%). A report produced by Statistics Canada (28) also contrasted various health indicators in youth aged 12 to 17 years using data from the 2000/01 Canadian Community Health Survey. Seven geographic categories were used to define urban-rural status, with the Census Division as the unit of allocation into the categories. The findings of the report indicated that boys in small towns (population 2,500 – 19,999) were the most likely to be overweight or obese. No urban/rural gradients in overweight and obesity were found among girls.

2.5 Influence of Neighbourhood Food Retailers on Obesity

2.5.1 Increased use of Restaurants and Out of Home Food Sources

There has been an overall decrease in the percentage of energy obtained from foods eaten at home. Since 1977-78, the percentage of total food energy eaten at home decreased from 74.1% to 60.5% among 12 to 18 year olds (29). During the same time period, the percentage of total food energy obtained from full-service and fast food restaurants jumped from 5.3% to 19.3%.

In light of recent trends in eating patterns, the influence of food retailers on obesity levels in youth deserves further examination. Because restaurant foods tend to have more calories per serving, a higher proportion of calories from fat, and a lower nutritional value than food prepared at home (30), there is concern that this could be contributing to the increase in obesity among youth. Results from a longitudinal study by Thompson et al. (31) demonstrated that fast food consumption is positively associated with increasing BMI among adolescent girls, where those who ate fast food more
frequently have a greater increase in a sex-specific normalized BMI values. Thus, the increased consumption of fast food can predispose youth to excess weight gain.

2.5.2 Influence of Food Retail Environment on Obesity

Access to food retailers has been found to be associated with levels of adiposity among adult populations. Morland et al. (1) used multilevel modeling to examine effects of distributions of food retailers on rates of obesity in participants in the Atherosclerosis Risk In Communities Study. Participants were from selected census tracts in Mississippi, North Carolina, Maryland, and Minnesota. The presence of supermarkets within residents’ census tracts was found to be associated with lower levels of obesity (prevalence ratio = 0.83, 95% confidence intervals: 0.75-0.92), while the presence of convenience stores was associated with a higher prevalence of obesity (prevalence ratio = 1.16, 95% confidence intervals: 1.05-1.07), after adjusting for all types of food retailers, gender, race/ethnicity, age, income, education, and physical activity. However in a study of adults in 4 cities in California, Wang et al. (32) found that closer proximity to supermarkets and ethnic markets and a high density of grocery stores were each associated with a higher BMI, but in women only. These results were not corroborated by Mobley et al. (33) who found no meaningful relationship between food retailers (fast food restaurants, full service restaurants, and convenience stores) and BMI in a study of low income women in five American states (Connecticut, Massachusetts, Nebraska, North Carolina and South Dakota). Finally, Maddock (34) performed a multilevel analysis investigating the relationship between the prevalence of fast food restaurants and obesity using the U.S. Behavioral Risk Factor Surveillance System for all states except Alaska. When number of residents per fast food restaurant and square miles per fast food
restaurant were entered into a hierarchical multiple regression, 6% of the variance in state-level obesity was explained, after controlling for population density, ethnicity, age, gender, physical inactivity, and fruit and vegetable intake.

Few studies have examined relationships between the availability of food retailers and obesity in children and youth. Austen et al. (35) investigated the degree of clustering of fast food restaurants around kindergarten, elementary, and secondary schools across Chicago. They found that clustering occurred around schools, with 3 to 4 times as many fast food restaurants located within 1.5 km of schools than would be expected if fast food restaurants were located in a way that was unrelated to school locations. Although this provides some evidence of increased exposure to fast food around schools, there are few studies measuring the level of adiposity in relation to the density and type of food retailers.

In a longitudinal study of kindergarten to grade 3 students across the U.S., Sturm and Datar (36) used multilevel modeling to determine whether the per capita number of grocery stores, convenience stores, full-service restaurants, and fast food restaurants were related to changes in BMI. The per capita number of fast food restaurants was associated with higher BMI scores, but this association was of marginal statistical significance (p<0.10). In a study of low income pre-school children in Cincinnati, Burdette and Whittaker (37) were unable to find an association between the distance to the nearest fast food restaurant and obesity after controlling for poverty, race, and sex.

Studies examining the relationship between the food environment and individual-level measures of overweight and obesity in young people are few in number and have
been conducted exclusively in the U.S. Therefore, future studies investigating this relationship in other countries, including Canada, are warranted.

2.5.3 Socioeconomic Status and Food Retailers

The density and type of food retailers has been associated with neighbourhood level deprivation in ecological studies. Results from a study in New Orleans showed that neighbourhoods that were predominantly poor and black had more fast food restaurants per square mile compared to white neighbourhoods (38). Another study also explored access to a wider variety of food retailers in selected census tracts in North Carolina, Maryland, and New York (39). Low income neighbourhoods had more than four times as many grocery stores and only half as many supermarkets compared to the wealthiest neighbourhoods. This was also confirmed by Powell et al. (40), who examined chain supermarkets, non-chain supermarkets, grocery stores, and convenience stores across the U.S. They found that low income neighbourhoods had fewer chain supermarkets compared to middle income neighbourhoods, even after controlling for income and other covariates. Low income areas also had a greater number of non-chain supermarkets and grocery stores compared to middle income neighbourhoods. The lack of supermarkets in low income neighbourhoods is significant because residents may be forced to depend on smaller stores with less selection of foods and higher prices, whereas supermarkets tend to have a greater selection of healthy foods (2).

The relationship between neighbourhood SES and accessibility of food retailers has only recently been studied in Canada. Apparicio et al. (41) performed a detailed analysis of the accessibility of selected chain supermarkets to residents living in Montreal. There was no demonstrable lack of accessibility in poorer SES
neighbourhoods. In fact, they found that residents living in low income areas lived closer, on average, to the nearest supermarket than residents of more affluent areas. For the census tracts with the highest deprivation and lowest accessibility, the average distance to the nearest supermarket was 816 meters, a distance that is walkable within 10 minutes by most people. These results may reflect the unique environment in Montreal, and may not be transferable to other cities. Furthermore, the quality, selection, and price of food were not evaluated in this study, and residents may not necessarily shop at the closest grocery stores.

Giskes et al. (42) examined whether perception of price differences and availability of healthier options at grocery stores influenced purchase of recommended food choices in Brisbane, Australia. They found that lower SES groups were less likely to purchase some of the recommended choices (i.e., choices that are lower in saturated fat, sodium, sugar, salt, or higher in fibre), and that the relationship was not largely affected by the objective availability of the food items or differences in price, which were measured by supermarket audits. Rather, respondents’ perceptions of availability explained most of the inequality (5-10%) in healthy food purchasing between SES groups.

While relationships between exposure to food retailers and neighbourhood-level SES have been investigated, no studies to date have examined the food environment and its association with SES in the vicinity of school neighbourhoods. If there are differences in exposure to food retailers by school-level SES, programs may be needed to address potential disparities. This may be particularly relevant to certain types of food retailers
(i.e., fast food restaurants, convenience stores), that may potentially be targeting children and youth during their lunch hour, breaks, and/or on their way to and from school.

**2.6 Influence of Neighbourhood on Physical Activity Participation and Obesity**

The built environment within neighbourhoods may also influence overweight and obesity in youth. To illustrate, both objectively measured and self-report data indicate that physical activity is associated with the presence of parks within walking distance of the home in adolescents (43, 44). In addition to the presence of nearby parks the number of private recreational facilities have been associated with moderate to vigorous physical activity levels in adolescents (45). Similar to research on access to food retailers and SES, access to fitness facilities has also been found to differ by SES among youth. A study by Gordon-Larsen et al. (46) found that higher SES neighbourhoods have a significantly higher odds of having a recreational facility compared to low SES neighbourhoods. Within the same study, the presence of recreational facilities was associated with greater relative odds of physical activity and a lower odds of overweight (46). Their presence influences obesity rates by acting as facilitators of physical activity. Recreational facilities are subject to similar area-level SES influences as food retailers, putting lower SES neighbourhoods at a disadvantage with respect to overweight and obesity.

**2.7 Summary**

Given the small number of studies investigating the relationship between access to food retailers and obesity in youth, it is difficult to conclude whether the proximity of food retailers is associated with higher levels of obesity in youth. The study by Sturm and
Datar (36) was the only one to use cross national data. Conclusions made from the study by Burdette and Whitaker (37) may be limited by the relatively homogenous SES of the children included in their study. Thus, more socio-economically diverse areas may need to be included in studies in order to obtain findings that are generalizable. Results from studies in obesity have also been found to vary in different countries. Findings from the U.S. tend to support the idea that accessibility to healthy food plays a role in differences in obesity levels. However, results from other countries have not shown neighbourhood differences in food accessibility and diet. Cummins and Macintyre (47) suggest that the association found in the U.S. is stronger because residential segregation along socioeconomic and racial lines may be more pronounced compared to other countries. Thus, the environmental characteristics may differ across nations, leading to the inconsistent findings and limiting the generalizability of previous studies.
References


27. Plotnikoff RC, Bercovitz K, Loucaides CA. Physical activity, smoking, and
obesity among Canadian school youth. Comparison between urban and rural

28. Mitura V, Bollman R. Health status and behaviours of Canada's youth: A rural-
urban comparison. (No. 21-006-XIE) Canada: Statistics Canada.

29. Nielsen SJ, Siega-Riz AM, Popkin BM. Trends in food locations and sources

30. Guthrie JF, Lin BH, Frazao E. Role of food prepared away from home in the
Behav 2002;34:140-50.

31. Thompson OM, Ballew C, Resnicow K, et al. Food purchased away from home as
a predictor of change in BMI z-score among girls. Int J Obes Relat Metab Disord

32. Wang MC, Kim S, Gonzalez AA, MacLeod KE, Winkleby MA. Socioeconomic
and food-related physical characteristics of the neighbourhood environment are

Environment, obesity, and cardiovascular disease risk in low-income women. Am

34. Maddock J. The relationship between obesity and the prevalence of fast food


CHAPTER 3: MULTILEVEL MODELING

3.1 Utility of multi-level modeling

A considerable proportion of the research investigating the relationship between food environment and obesity are ecological in nature. Although this approach allows for some insight into possible mechanisms behind this relationship, inferences cannot be made about individual behaviour based solely on group-level data, which is defined as an ecological fallacy. Multi-level modeling is a sophisticated statistical approach that simultaneously incorporates group- and individual-level data. This is a particularly useful approach for the study of the environmental determinants of obesity.

3.2 What is multilevel modeling?

Multilevel modeling is a statistical technique used when individual-level observations are clustered within groups. For example, in the World Health Organization’s Health Behaviour in School Aged Children Survey (1), students are grouped within schools, and as a result, health outcomes for students within a school may be correlated. To account for this correlation in regression models, multilevel modeling employs the use of a nested set of equations for the regression: one for individual-level variables and one for group-level variables. This statistical approach not only accounts for the effect of clustered data, it can be used to simultaneously analyze the effect of both individual- and area-level variables through the use of nested equations (2, 3). For instance, one could determine the independent effects of an individual-level SES exposures (e.g., household income) and area-level SES exposures (e.g., average...
household income in neighbourhood) on obesity levels, as done in the studies in adults outlined in Section 2.5.2 of the literature review.

Merlo et al. (4) used a hypothetical example to demonstrate simple and complex variations slopes and intercepts across different groups. First, a regression line was created for level 1 (individual-level) variables. Then regression lines representing each level 2 (area) unit (i.e., neighbourhoods) were created. Simple level 2 variations occur when the intercepts vary across level 2 units, but the slope remains constant, as shown in Figure 3.1 (page 31). This indicates that the relationship between the exposure and outcome remains constant across level 2 units, although each level 2 unit may have a different value for the outcome variable. Complex variations occur when both the intercepts and the slopes for the level 2 units vary (Figure 3.2, page 32), indicating that the relationship between the exposure and outcome differs across the level 2 units. To establish whether simple or complex level 2 variations occur, the variance of level 2 variables are tested to determine if they are significantly different from zero.

3.3 Advantages of multi-level modeling

Multilevel modeling addresses the statistical complexities that arise when individuals are nested within groups. Ignoring group level variation violates the assumption of independence and can result in incorrect standard errors and inefficient estimates (5). This statistical approach not only accounts for the effect of clustered data, it can be used to simultaneously analyze the effect of both individual- and area-level variables through the use of nested equations (2, 3). A multilevel modeling strategy is well-suited for determination of the impact of the food environment (e.g., number of fast
food restaurants in the neighbourhood) on obesity independent of the individual-level covariates such as physical activity and individual SES measures that may also affect obesity.

3.4 Special Considerations

Multilevel modeling is not without its criticisms. Diez-Roux (5) outlines some important issues that need to be considered when using multilevel analysis. First, group-level variables should be important constructs on their own and should not be used as proxies for individual-level data that are missing. For example, neighbourhood unemployment rates may have a unique and separate effect on health compared to the effects of an individual exposure to un- or under-employment. Also, groups used in multilevel analysis should be meaningful in order to explain the outcome, and not simply convenient or arbitrary groupings of individuals. Finally, researchers have expressed concern over attributing group-level differences to individual-level differences that are unaccounted for (5). However, group-level effects do not operate strictly independent of individual effects since it is the group effects that can affect an individual’s behaviour. Thus, multilevel modeling is a complex procedure that has advantages over traditional statistical modeling, but variable selection should be done carefully and be supported by theoretical foundations.
References


Figure 3.1. Hypothetical Example of Simple Level 2 Variation - Constant Slopes

Source: Merlo et al., Reference 4
Figure 3.2. Hypothetical Example of Complex Level 2 Variation – Varying Slopes

Source: Merlo et al., Reference 4
CHAPTER 4: MANUSCRIPT 1

This manuscript is written according to specifications for submission to the peer-reviewed journal *Canadian Journal of Public Health*.

**Title:**

Density and type of food retailers surrounding school-aged youth: variations across socioeconomic status

**Authors:**

Laura M. Seliske \(^1\)
William Pickett \(^1\)
Ian Janssen \(^1,2\)

\(^1\) Department of Community Health and Epidemiology, Queen’s University, Kingston, ON
\(^2\) School of Kinesiology and Health Studies, Queen’s University, Kingston, ON
ABSTRACT

Background: Obesity research is beginning to focus on the effects the environment on obesity levels. Changes in the food environment (number and type of food retailers) may be an important population health strategy to reduce obesity rates. Lower socioeconomic status (SES) neighbourhoods may have differential access to certain food retailers, such as fast food restaurants, which may explain higher obesity rates in this segment of the population. Very little is known about the food environment surrounding schools in our country.

Objective: To determine if there is a socioeconomic gradient to access in various types of food retailers in the immediate vicinity as well as the broader neighbourhood of 188 schools participating in the 2005/06 Health Behaviour in School-Aged Children (HBSC) Survey.

Research Design and Methods: Numbers of food retailers were obtained for both a 1 km and 5 km radius around participating schools using street addresses. Types of retailers included were: full-service restaurants, fast food restaurants, sub/sandwich retailers, donut/coffee shops, convenience stores and grocery stores. School addresses were linked to 2001 Census data to obtain area-level SES for each school. A trend test was performed to determine if there was a gradient in exposure to each type of food retailer by SES.

Results: SES was associated with the presence of full-service restaurants within 1 km of schools, with low SES school neighbourhoods having access to fewest food retailers. The gradient was only significant for sub/sandwich retailer and coffee/donut shops when the number of food retailers per 10,000 people was analyzed.
Conclusions: Most Canadian students have access to a variety of food retailers within walking distance of their schools. Given the ease of access to outside retailers, school-based strategies that limit access to retailers and provide education about healthy choices are warranted. For school neighbourhoods, socioeconomic status does not appear to be an important influence on access to food retailers.

Keywords: food, residence characteristics, social class, schools
INTRODUCTION

There is growing concern about the prevalence of overweight and obesity among children and adolescents. In 2004, 18% of Canadian children aged 2 to 17 were overweight and 8% were obese, with a rapid increase occurring over the past two decades (1). There are numerous health risks associated with overweight and obesity in youth, both physical and social in nature.(2) Although the treatment of childhood obesity has received considerable research attention, interventions aimed at weight reduction have had limited success, and few studies have assessed whether obese youth are able to sustain weight loss over a prolonged period of time.(3) This is part of a broader criticism of obesity research, where there has been an overemphasis on modification of individual behaviours, and the complex social and environmental contexts that influence behaviours have been largely ignored.(4) As a result, research in the obesity field is starting to focus on aspects of the physical environment that may impact obesogenic behaviours.

Studies of Canadian youth have shown that neighbourhood-level socioeconomic status (SES) indicators, such as unemployment rate and median family income, are independent predictors of overweight and obesity.(5, 6) Although neighbourhood SES is associated with obesity in young people, the mechanism that underlies this relationship is poorly understood. One possible explanation is differential access to food retailers across neighbourhoods. Greater accessibility to a variety of healthy, affordable foods within neighbourhoods may be associated with a reduced prevalence of obesity by facilitating healthy nutritional choices. Conversely, having preferential access to food of poor nutritional and high caloric value may promote obesity.
Ecological studies conducted in the U.S. report that neighbourhood level deprivation is associated with the density and type of food retailers such that poorer neighbourhoods have more fast food restaurants, fewer supermarkets, and more convenience stores. To date, no studies have examined SES and its association with accessibility to food retailers surrounding schools. These food sources are highly relevant for young people, and the density of some types of food retailers (e.g., fast food restaurants) around schools is extremely high. Many existing studies investigating the relationship between SES, the food environment, and obesity have taken place in large cities in the U.S. and involve preschool-aged children or those in the early grades of elementary school. Little attention has been paid to older youth who are experiencing increased autonomy and may be strongly influenced by their food environment.

The objective of this study was to describe the food environment surrounding the school neighbourhoods of Canadian youth and to determine whether access to food retailers differs by area-level SES. Food retailers in close proximity to schools (within 1 km) and food retailers within the broader school neighbourhood (within 5 km) were examined.

**METHODS**

*Schools*

Schools involved in this study included elementary and high schools that participated in the 2005/06 Canadian Health Behaviour in School-Aged Children (HBSC) Survey. The HBSC is conducted in collaboration with the World Health Organization. Students in grades 6 to 10 from 188 schools across Canada were included in the survey.
Schools were selected for this study using a weighted probability technique to ensure that the sample was representative by regional geography and key demographic features such as religion, community size, school size, and language of instruction. Schools from each province and territory, as well as urban and rural locations were represented.

**Socioeconomic Status**

Socioeconomic status (SES) was established for the population living within a 5 km radius of each participating HBSC school and was used as a proxy for neighbourhood SES. Information from the 2001 census was obtained for the population living within the 5 km radius of the schools using PCensus software (2001 Census of Canada Profile Data; version 2001; Tetrad Computer Applications Inc, Bellingham, WA). Average household income was divided by the number of households within a 5 km radius to obtain the mean household income per person, which was used to describe one component of SES. Similarly, the unemployment rate and percent of the population with less than a high school education was obtained for those living within 5 km of each of the 188 schools. Each school neighbourhood was ranked on each of the three SES measures, and the rankings were summed to create a total SES score. This score was used to divide the schools into tertiles, which was used to classify school neighbourhoods into low, medium and high SES.

**Food Retailers**

The number of food retailers within 1 km and 5 km were estimated for each school using an Internet-based food retailer database (www.yellow.ca) based upon the
street addresses of schools participating in the HBSC survey. The one kilometre radius was chosen because it corresponds to an approximate 10-15 minute walk,(10, 11) and it is expected that students were able to access these retailers during their lunch hour and breaks, or on their way to and from school. In addition, information on food retailers within the broader school neighbourhood was collected, representing food retailers that students and their families may have close access to. This was estimated using the number of retailers within a 5 km radius of each school.

The retailers were grouped as follows: full-service restaurants, fast food retailers (fast food restaurants, pizza restaurants, hamburger restaurants), sub/sandwich shops (sandwich shops, submarine shops, delicatessens), donut/coffee shops (donut shop, coffee shop), convenience stores (convenience store, variety store), and grocery stores. These retailers were chosen because they represent a variety of food selection, from retailers that are anticipated to provide relatively healthier options, such as sub/sandwich shops,(12) as well as retailers that sell foods that are likely to promote unhealthy eating and obesity such as fast food restaurants(13) and convenience stores. These categories were also consistent with those used in previous research primarily conducted in the U.S.(7-9, 14-18)

To ensure that each food retailer was classified into a mutually exclusive category, a classification strategy was created, whereby large chain retailers were assigned to one of the categories of food retailers. Food retailers that were in similar categories were grouped together (i.e., coffee shops and donut shops). Next, all food retailers were checked to see if they fell into one category. Where a food retailer fell into two categories (i.e., convenience store and grocery store), a set of predetermined key words were used to
assign the food retailer into an appropriate category. For the specific details regarding the classification strategy, see Appendix A and B.

Each type of food retailer within 1 km of the schools were categorized into two groups: those with no food retailers and those with one or more retailer. At this distance, classifying schools as either having access or not having access to one or more food retailers was more important than determining how many food retailers students had access to. Due to the skewed distribution of food retailers, the food retailers within a 5 km radius of the schools were classified into four groups: the first group had no retailers and the remaining neighbourhoods were divided into tertiles which are hereafter referred to as the low, medium, and high exposure groups.

A population-based food retailer density was also calculated by dividing the number of each type of retailer by the number of people living within the 5 km radius. The number of people living within 5 km of schools was estimated using PCensus, using the schools’ street addresses. Where an exact match could not be made, the postal code was used instead. The number of food retailers was divided by the population within 5 km and was multiplied to obtain the number of retailers per 10,000 people. The density measure was calculated in order to take into consideration the size of the population sharing access to the various food retailers and to determine whether the density was related to accessibility. Furthermore, previous studies have employed the density rather than the number of food retailers,(8, 14, 19, 20) making it possible to compare our results with previous literature.
**Statistical Analysis**

Comparisons were made to determine whether the number (1 km and 5 km) and population density (5 km) of food retailers surrounding the 188 schools varied by the area-level SES. Because the food retailer exposures and SES were ordered categories, the Jonckheere-Terpstra test,(21, 22) was used to establish whether SES was associated with food retailer exposure. All analyses were conducted using SAS v9.1 software (SAS Institute, Cary, NC).

**RESULTS**

Table 1 shows the characteristics of the 188 schools involved in the Canadian 2006 HBSC survey. Students from grades 6 to 10 were included in the survey, with a roughly even distribution of classrooms across classroom grades, although there were slightly fewer students in the upper grades. The majority of the schools selected for the survey were public schools, and approximately 20% of the schools surveyed were separate (Roman Catholic). A large majority of the schools were located in an urban setting, which was defined as being located within a Census Metropolitan Area (<100,000 people) or Census Agglomeration (<10,000 people). Schools from all provinces and territories were included in the survey.

The number and percentage of schools that had various food retailers within a 1 km and 5 km distance is shown in Table 2. Overall, 74% of the schools (139/188) had at least one type of food retailer within 1 km and 92% of the schools (173/188) had at least one food retailer within 5 km. Table 2 also shows the median number of food retailers for the 5 km distance as well as the number of food retailers per 10,000 people. The most
common type of food retailer for both distances was the full-service restaurant, while the least common was sub/sandwich retailers.

For the 1 km distance, the association between SES and food retailer access was significant (p<0.05) for full-service restaurants only (Figure 1). For low SES schools, 28.3% had one or more full-service restaurants and access increased for medium and high SES schools, where 33.6% and 38.3%, respectively, had one or more full-service restaurant. For the 5 km distance, the association between SES and number of food retailers was significant (p<0.05) across all food retailer types (Table 3). Schools in low SES neighbourhoods had the fewest number of all 6 types of food retailers, and access increased as SES increased. For example, 46% of low SES schools did not have a fast food retailer within 5 km, while only 24.2% and 22.2% of medium and high SES schools, respectively, did not have a fast food retailer within 5 km. When population density was taken into account at the 5 km distance, only the number of sub/sandwich and donut/coffee retailers differed significantly by SES (Table 3). Low SES schools had the lowest number of sub/sandwich and donut/coffee retailers per 10,000 people. No SES gradients were found for the other food retailer types.

DISCUSSION

A primary finding of this study is that most students in Canada have at least one food retailer within walking distance of their school that they can easily reach during their lunch hour, during breaks, and/or on their way to and from school. Nearly 60% of the schools had access to at least one convenience store, and approximately 30% had access to fast food restaurants, sub/sandwich shops, and donut/coffee shops. Although the most
prevalent type of food retailer was full-service restaurants, their effect might not be important given the time and cost required to purchase food. Nevertheless, this indicates that students have access to a variety of food sources other than school cafeterias and vending machines during the school day. School board administrators undoubtedly take this into account when considering policies limiting access to food retailers outside school property. However, school policies may be less feasible for high schools, where students may have access to transportation and more freedom to leave school property. Existing policies could involve educational programs emphasizing healthy options from the food options available to them both within and outside of school property.

Only full-service restaurants showed a trend in exposure across SES categories for the 1 km radius, with low SES schools having the least access. Access to full-service restaurants within 1 km of schools might not be of practical importance due to time and cost constraints for students. At the broader school neighbourhood level, in particular within a 5 km radius of the school where we believe most students would live, access to food retailers was very abundant, with fewer than 10% of school neighbourhoods not having access to at least one food retailer. The effect of SES on food retailer availability at the 5 km distance was more apparent than it was in the immediate school environment. The number of food retailers within 5 km showed strong gradients across school-level SES groups, with a consistent relationship observed for all types of food retailers. Interestingly, all types of food retailers were more prevalent in the higher SES groups, and low SES groups had the least access. The trend in food retailer access was not as strong when the number of food retailers per 10,000 people was analyzed, with only
sub/sandwich shops and coffee/donut shops showing a SES gradient and fast food restaurants showing a marginally significant (p=0.06) gradient.

Thus, once population density was accounted for, the SES gradient in exposure to food retailers largely disappeared. This may be because individuals living in rural locations are more likely be of a lower SES compared to their urban counterparts (23). Because low SES school neighbourhoods did not have a disproportionately high number of food retailers that sell energy dense foods (i.e., fast food restaurants, convenience stores) and disproportionately high number of food retailers that sell nutrition foods (i.e., grocery stores), policies that regulate the number and type of food retailers within lower SES neighbourhoods may not be needed.

The results of our study have contradicted some of the previous literature on the relationship between food retailers and area-level SES. Block et al.,(7) Reidpath et al. (19) and Cummins et al.(20) found that lower SES neighbourhoods had a higher concentration of fast food restaurants. In a case study of fast food retailers in the United Kingdom, researchers analyzed access to food retailers by SES and found differing results depending on whether chain retailers were analyzed exclusively or not. When fast food retailers were limited to chain retailers, low SES neighbourhoods tended to have more fast food retailers present(20). However, the inclusion of both chain and non-chain retailers yielded similar results as our study, whereby medium and high SES neighbourhoods had more fast food retailers(24). Previous studies in the U.S. have also reported that residents in low SES neighbourhoods tend to have more access to grocery stores and less access to supermarkets.(17, 18) A recent study by Apparicio et al.(11) in
the city of Montreal, Quebec concluded that geographic accessibility to supermarkets was not deemed to be more difficult for low SES neighbourhoods.

It is apparent from discrepancies in study findings that the relationship between access to food retailer and SES is complex. A possible explanation for this is that the disparities in SES and the food environment differ across countries and regions. It is important to note that many of the studies from the U.S. use the racial composition of neighbourhoods as a way of measuring SES. This relationship might be unique to the U.S., particularly in southern regions, and may not be applicable to the Canadian context. It is also possible that the demand for certain types of food retailers within different countries and regions may be different as well, lending to the inconsistency in the findings. Finally, in constructing our area-level SES categories, we used tertiles, while other studies have used quartiles(19) and quintiles,(20) and therefore the discrepancies in findings may be due to a higher disparity between low and high SES neighbourhoods.

It is important to acknowledge the limitations of this study. Without a standardized classification system available for categorizing food retailers, we were limited to modifying the output provided by an Internet database to meet our study objectives. This may have led to misclassification of food retailers. Furthermore, we did not separate the effects of chain and non-chain retailers, which have been shown to differ based on SES.(24, 25) Also, the Census data used to construct SES groups was collected in 2001, while the information on food retailers was collected in 2006, which may affect the conclusions made in this study if systematic changes in SES occurred during this time period. The use of a 5 km radius as a proxy for the school neighbourhood may be problematic because some students are likely to live outside this distance and our results
may not be applicable to them. Finally, having more schools in this study would have increased statistical power and resulted in more statistically significant findings, as there were a number of associations with a p-value slightly above the cut off of 0.05.

This study provides insight into the food retail environment around Canadian schools. Students have access to a wide variety of food retailers, although this was found to differ by neighbourhood SES. However, the direction of the relationship in Canada differs from the majority of the literature, which is largely from the U.S., indicating that there may be unique influences directing the distribution of food retailers across neighbourhoods and around schools. The food environment around schools may be an important area for intervention given the recent shift in focus from individual- to area-level determinants of obesity. Thus, school policy may be important in addressing the accessibility to food retailer within close proximity to schools. However, policy initiatives addressing equality in access across neighbourhood SES may not be needed at the municipal level. Because this study is ecological in nature, further research is needed linking access to food retailers to individual level attributes such as food consumption and measures of overweight and obesity.
References


22. Terpstra TJ. The asymptotic normality and consistency of Kendall's test against trend, when ties are present in one ranking. Indagationes mathematicae 1952;14:327-333.


Table 1. Characteristics of the 188 schools in the HBSC survey

<table>
<thead>
<tr>
<th>Province</th>
<th>Number</th>
<th>Percent (S.E.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alberta</td>
<td>23</td>
<td>12.2 (2.4)</td>
</tr>
<tr>
<td>British Columbia</td>
<td>17</td>
<td>9.0 (2.1)</td>
</tr>
<tr>
<td>Manitoba</td>
<td>7</td>
<td>3.7 (1.4)</td>
</tr>
<tr>
<td>New Brunswick</td>
<td>7</td>
<td>3.7 (1.4)</td>
</tr>
<tr>
<td>Newfoundland</td>
<td>6</td>
<td>3.2 (1.3)</td>
</tr>
<tr>
<td>Northwest Territories</td>
<td>1</td>
<td>0.5 (0.5)</td>
</tr>
<tr>
<td>Nova Scotia</td>
<td>10</td>
<td>5.9 (1.2)</td>
</tr>
<tr>
<td>Nunavut</td>
<td>2</td>
<td>1.1 (0.7)</td>
</tr>
<tr>
<td>Ontario</td>
<td>51</td>
<td>27.1 (3.2)</td>
</tr>
<tr>
<td>PEI</td>
<td>4</td>
<td>2.1 (1.1)</td>
</tr>
<tr>
<td>Quebec</td>
<td>45</td>
<td>23.9 (3.1)</td>
</tr>
<tr>
<td>Saskatchewan</td>
<td>12</td>
<td>6.4 (1.8)</td>
</tr>
<tr>
<td>Yukon</td>
<td>2</td>
<td>1.1 (0.7)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Classroom Grade</th>
<th>Number</th>
<th>Percent (S.E.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td>95</td>
<td>22.3 (2.0)</td>
</tr>
<tr>
<td>7</td>
<td>91</td>
<td>21.4 (2.0)</td>
</tr>
<tr>
<td>8</td>
<td>87</td>
<td>20.4 (2.0)</td>
</tr>
<tr>
<td>9</td>
<td>81</td>
<td>19.0 (1.9)</td>
</tr>
<tr>
<td>10</td>
<td>72</td>
<td>16.9 (1.8)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>School Board</th>
<th>Number</th>
<th>Percent (S.E.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Public Schools</td>
<td>155</td>
<td>82.4 (2.8)</td>
</tr>
<tr>
<td>Separate (Roman Catholic)</td>
<td>33</td>
<td>17.6 (2.8)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Urban-Rural Status</th>
<th>Number</th>
<th>Percent (S.E.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Urban</td>
<td>115</td>
<td>61.8 (3.6)</td>
</tr>
<tr>
<td>Rural</td>
<td>71</td>
<td>38.2 (3.6)</td>
</tr>
</tbody>
</table>
Table 2. Description of the food environment surrounding the 188 schools in the HBSC survey

<table>
<thead>
<tr>
<th>Food Retailer</th>
<th>Number (%) of Schools with ≥ 1 Retailer within 1 km</th>
<th>Number (%) of Schools with ≥ 1 Retailer within 5 km</th>
<th>5 km Radius: Number Median</th>
<th>IQR</th>
<th>5 km Radius: Number per 10,000 people Median</th>
<th>IQR</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full Service Restaurant</td>
<td>128 (68.1)</td>
<td>169 (89.9)</td>
<td>18.0</td>
<td>4.5 – 73.5</td>
<td>11.3</td>
<td>5.5 -17.1</td>
</tr>
<tr>
<td>Fast Food Restaurant</td>
<td>59 (31.4)</td>
<td>130 (69.2)</td>
<td>3.5</td>
<td>0.0 – 9.0</td>
<td>0.9</td>
<td>0.0 - 2.2</td>
</tr>
<tr>
<td>Sub/Sandwich Shop</td>
<td>53 (28.2)</td>
<td>125 (66.5)</td>
<td>1.5</td>
<td>0.0 – 5.5</td>
<td>0.6</td>
<td>0.0 - 1.2</td>
</tr>
<tr>
<td>Donut/Coffee Shop</td>
<td>64 (34.0)</td>
<td>130 (69.2)</td>
<td>3.0</td>
<td>0.0 – 11.0</td>
<td>1.2</td>
<td>0.0 - 2.4</td>
</tr>
<tr>
<td>Convenience Store</td>
<td>109 (58.0)</td>
<td>150 (79.8)</td>
<td>4.5</td>
<td>1.0 – 20.0</td>
<td>2.7</td>
<td>0.6 - 4.5</td>
</tr>
<tr>
<td>Grocery Store</td>
<td>n/a</td>
<td>143 (76.1)</td>
<td>3.0</td>
<td>1.0 – 10.0</td>
<td>1.4</td>
<td>0.1 - 2.7</td>
</tr>
</tbody>
</table>

Percent of schools in brackets
IQR = Interquartile Range
Table 3. Association between area-level SES and food retailers within a 5 km radius of the 188 schools participating in the HBSC survey

<table>
<thead>
<tr>
<th>Food Retailer Type</th>
<th>Number of Food Retailers (S.E.)</th>
<th>Number of Food Retailers per 10,000 people (S.E.)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>No Exposure</td>
<td>Low</td>
</tr>
<tr>
<td>Full-Service Restaurants †</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Low SES (n=63)</td>
<td>20.6 (2.9)</td>
<td>36.5 (3.5)</td>
</tr>
<tr>
<td>Med SES (n=62)</td>
<td>3.2 (1.3)</td>
<td>32.3 (3.4)</td>
</tr>
<tr>
<td>High SES (n=63)</td>
<td>6.4 (1.8)</td>
<td>19.1 (2.9)</td>
</tr>
<tr>
<td>Fast Food Restaurants †</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Low SES (n=63)</td>
<td>46.0 (3.6)</td>
<td>28.6 (3.3)</td>
</tr>
<tr>
<td>Med SES (n=62)</td>
<td>24.2 (3.1)</td>
<td>16.1 (2.7)</td>
</tr>
<tr>
<td>High SES (n=63)</td>
<td>22.2 (3.0)</td>
<td>27.0 (3.2)</td>
</tr>
<tr>
<td>Sub/Sandwich Shops †,*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Low SES (n=63)</td>
<td>50.8 (3.6)</td>
<td>27.0 (3.2)</td>
</tr>
<tr>
<td>Med SES (n=62)</td>
<td>27.4 (3.2)</td>
<td>16.1 (2.7)</td>
</tr>
<tr>
<td>High SES (n=63)</td>
<td>22.2 (3.0)</td>
<td>33.3 (3.4)</td>
</tr>
<tr>
<td>Donut/Coffee Shops †,†</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Low SES (n=63)</td>
<td>50.8 (3.6)</td>
<td>17.5 (2.8)</td>
</tr>
<tr>
<td>Med SES (n=62)</td>
<td>25.8 (3.2)</td>
<td>17.7 (2.8)</td>
</tr>
<tr>
<td>High SES (n=63)</td>
<td>15.9 (2.7)</td>
<td>33.3 (3.4)</td>
</tr>
<tr>
<td>Convenience Stores *</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Low SES (n=63)</td>
<td>28.6 (3.3)</td>
<td>28.6 (3.3)</td>
</tr>
<tr>
<td>Med SES (n=62)</td>
<td>17.7 (2.8)</td>
<td>22.6 (3.1)</td>
</tr>
<tr>
<td>High SES (n=63)</td>
<td>14.3 (2.6)</td>
<td>25.4 (3.2)</td>
</tr>
<tr>
<td>Grocery Stores †</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Low SES (n=63)</td>
<td>36.5 (3.5)</td>
<td>34.9 (3.5)</td>
</tr>
<tr>
<td>Med SES (n=62)</td>
<td>21.0 (3.0)</td>
<td>22.6 (3.1)</td>
</tr>
<tr>
<td>High SES (n=63)</td>
<td>14.3 (2.6)</td>
<td>30.2 (3.3)</td>
</tr>
</tbody>
</table>

* (increasing trend in) percent of food retailer within 5 km significant at p<0.05
† (increasing trend in) percent of food retailer within 5 km significant at p<0.01
FIGURE LEGEND

Figure 1. Trends in the number of food retailers within 1 km of schools by socioeconomic status. (* = p<0.05)
Figure 1

A bar chart showing the percent of schools across different SES categories (Low SES, Moderate SES, High SES) for various types of food outlets: Full-Service, Fast Food, Sub/Sandwich, Donut/Coffee, and Convenience. The chart indicates a comparison of the percentage of schools offering each type of food outlet in different SES categories.
CHAPTER 5: MANUSCRIPT 2

This manuscript is written according to specifications for submission to the peer-reviewed journal *American Journal of Clinical Nutrition*.

Title:

The influence of the food retail environment surrounding schools on overweight in Canadian students: a multilevel analysis

Authors:

Laura M. Seliske ¹
William Pickett ¹
Ian Janssen ¹,²

¹ Department of Community Health and Epidemiology, Queen’s University, Kingston, ON
² School of Kinesiology and Health Studies, Queen’s University, Kingston, ON
ABSTRACT

Background: There is concern about rising number of overweight and obese youth in populations of youth in Canada and globally. Recently, attention has been placed on studying preventive approaches. This includes consideration of environmental causes of obesity, including the food environment. Few studies have investigated the impact of the food retailer environment on overweight and obesity in youth, with few studies considering the food retail environment surrounding schools, and no studies of Canadian youth.

Objective: To determine whether there is a relationship between exposure to food retailers surrounding schools and overweight (including overweight and obese) among Canadian youth participating in the 2005/06 Health Behaviour in School-aged Children survey.

Research Design and Methods: The number of food retailers was obtained for both a 1 km and 5 km radius around all participating schools (n=178). Types of retailers included were: full-service restaurants, fast food restaurants, sub/sandwich retailers, donut/coffee shops, convenience stores, and grocery stores; as well as an index of total food retailers. Multilevel analyses were performed to estimate the effect of exposure to food retailers on overweight, while controlling for individual- and area-level covariates. Separate logistic regression models were fitted for food retailers within a 1 km and 5 km distance from schools.

Results: Each type of food retailer was associated with a decreased relative likelihood of overweight in youth for both the 1 km and 5 km bivariate analyses. The multivariate analyses revealed that total exposure to all food retailers was stronger than the individual effects of each food retailer type for the 1 km analysis and for the number of food retailers within 5 km,
while donut/coffee shops and grocery stores were each independently related to a decreased likelihood of obesity in the 5 km population analysis adjusted for density.

**Conclusions:** Exposure to various types of food retailers in school neighbourhoods was protective against overweight in Canadian school-aged youth. The opportunity to make healthy choices from a variety of options and influence of the unique Canadian context may explain the findings. Policies limiting the number and type of food retailers within close proximity to schools and within municipalities may not be a viable strategy for the prevention of overweight in Canadian youth.

**Keywords:** overweight, obesity, food retailers, adolescents, multilevel modeling, residence characteristics
INTRODUCTION

Childhood obesity is a significant public health problem. Among Canadian youth, one in four are either overweight or obese (1). Obese children and youth are at increased risk of numerous conditions including health and social issues such as hypertension (2, 3), insulin resistance (4), musculoskeletal problems (5), depression, and marginalization by peers (6, 7). Obese children and youth are considerably more likely to be obese as adults than are their normal weight peers (8-10).

Numerous obesity treatment strategies have been developed for children and youth, and many focus upon weight loss. Unfortunately, as indicated in a recent Cochrane review of randomized controlled trials, weight loss interventions in obese children and youth have been largely ineffective (11). Thus, efforts to address combating the childhood obesity epidemic may be better focused into obesity prevention than obesity treatment. In order to create optimal obesity prevention strategies and policies, it is helpful to have an understanding of the factors that contribute to childhood obesity.

Existing research on the etiology of obesity has focused upon obesity promoting (obesogenic) behaviours while largely ignoring the environmental factors that may dictate or mediate these behaviours (12). One aspect of the environment that may influence obesogenic behaviours is access to food retailers. To illustrate, some neighbourhoods may have a preponderance of food retailers and restaurants that sell unhealthy, high calorie foods that promote obesity. A state-level multilevel analysis conducted in the United States found that the density of fast food retailers was positively associated with the prevalence of obesity (13). A large cohort study of adults reported that a greater number of neighbourhood supermarkets was associated with a lower likelihood of obesity, while a greater number of
convenience stores was associated with a higher likelihood of obesity (14). These findings highlight the potential relevance of the food retail environment to the etiology of obesity.

Only two studies have examined the relationship between the food retailer environment and adiposity in children and youth. Burdette and Whitaker (15) did not find a relationship between the proximity to fast food restaurants and overweight in preschool-aged children living in a low income neighbourhood in Cincinnati, Ohio. Similarly, a longitudinal study of kindergarten students across the United States found that the number of neighbourhood fast food restaurants, full-service restaurants, and convenience stores did not impact upon rates of obesity (16). However, these studies were conducted in young children who do not have the same degree of food and dietary autonomy as older children. Furthermore, results from these American studies may not be transferable to Canadian population and associated food environments. Because the proportion of food eaten outside of the home has increased over the past few decades (17), the practice of eating out could play an important role in the increasing prevalence of obesity. Students spend a considerable portion of their day at school, and food retailers have been found to cluster around schools (18). The food environment surrounding schools may therefore be an important determinant of obesogenic behaviours.

The aim of this study was to determine whether a relationship exists between the nature of the food retail environment and rates of overweight and obesity in Canadian youth. Specifically, this study considers whether the number of different types of food retailers in the environment surrounding: 1) schools, 2) broader neighbourhood in which youth live, are related to obesity. This work was conducted in a large and representative sample of Canadian school-aged youth. It was hypothesized that the number of neighbourhood food retailers that
primarily sell calorically dense foods (fast food restaurants, convenience stores, and coffee/donut shops) would be positively associated with overweight and obesity, while the number of retailers that tend to offer healthier food choices (such sub/sandwich shops, full-service restaurants, grocery stores) would be negatively associated with overweight and obesity.

METHODS

Survey

The study sample involved Canadian students participating in the 2005/06 Health Behaviour in School-Aged Children (HBSC) Survey, a cross-national survey performed in collaboration with the World Health Organization. The sampling approach used the school class as the unit of selection, with classroom grades chosen to reflect the distribution of students in grades 6 to 10 in the Canadian population. Schools were selected using a weighted probability technique to ensure that the sample was representative by regional geography and key demographic features (religion, community size, school size, language of instruction). Schools from each province and territory, as well as urban and rural locations were represented. Youth attending private or special needs schools, incarcerated youth, and youth not enrolled in school were excluded. Combined, these excluded individuals represent 9% of the study age group in Canada (19). A total of 9,672 students from 188 schools participated in the 2005/06 survey. Ethics approval was obtained from the Queen’s University Research Ethics Board. Subject consent was obtained at the school board and school levels as well as from students and parents.

Area-Level Variables
**Food Retailers (Exposure)**

The number of food retailers within 1 km and 5 km of each school was estimated using the street addresses of schools participating in the HBSC survey. Data were obtained through an Internet-based food retailer database (www.yellow.ca). The 1 km radius was chosen because it corresponds to an approximate 10-15 minute walk (18, 20), and it was expected that students were able to access these retailers easily. In addition, information on food retailers within the broader school neighbourhood (5 km radius) was collected, representing food retailers that students and their families would have close access to in their neighbourhoods.

To ensure that each food retailer was classified into mutually exclusive categories, a classification strategy was created, whereby chain retailers were assigned to one of the categories of food retailers. Appendix A shows how the 12 food retailer types initially generated from the food retailer database were combined. Large chain retailers were categorized into groups first, and the remaining independent retailers were then categorized. Appendix B shows instructions that were used to categorize the food retailers.

For the 1 km radius, schools were categorized into two groups for each food retailer type: those with no exposure to food retailers and those with exposure to one or more retailer. At this distance, it was thought that it was not the number of food retailers that is important per se, but simply whether or not students had access to that type of food retailer. Food retailers within a 5 km radius of the schools were classified into four groups: the first group had no retailers and the remaining neighbourhoods were divided into tertiles, which will be referred to as low, medium, and high categories in the remainder of this paper.
A total food retailer index was also calculated by summing the number of the individual food retailers. For the 1 km distance, schools were divided into two groups, indicating whether the total number of food retailers was above or below the median. For the 5 km distance, schools were divided into quartiles based on their exposure to the total number of food retailers.

For the 5 km distance, a population food retailer density was also calculated by dividing the number of each type of retailer by the number of people living within the 5 km radius. The number of people living within 5 km of schools was obtained from PCensus (2001 Census of Canada Profile Data; version 2001; Tetrad Computer Applications Inc, Bellingham, WA) based upon the schools’ civic addresses. Where an exact match could not be made, the postal code was used in these estimates. The number of food retailers was divided by the population within 5 km and was multiplied to obtain the number of retailers per 10,000 people. The density measure was calculated to take into consideration the size of the population sharing access to the various food retailers, as previously performed in a number of similar studies (16, 21-23).

**Neighbourhood Covariates**

Because area-level SES and urban-rural status could potentially explain differences in the availability of food retailers, they were considered in all analyses. The area-level SES was obtained for individuals living within 5 km of schools using PCensus for the 2001 Canadian Census. Values for median household income, unemployment rate and percent of the population with less than a high school education were ranked for each of the schools and the sum of the rankings was obtained. This was used to then dichotomize the school neighbourhoods as high or low SES. Urban-rural status was obtained through a postal code
analyzer using Statistics Canada data. Schools that were located in areas that had a population greater than 10,000 people were considered urban, while those with a smaller population were not considered urban. School neighbourhood SES and urban-rural status were added into the model as potential covariates.

Individual-Level Variables

Overweight and Obesity (Outcome)

Students self-reported their height and weight on the HBSC survey, which was used to calculate their body mass index (BMI, kg/m²). Overweight and obesity were defined through BMI cutoff values developed by the International Obesity Task Force (24). These age- and sex-specific cutoff values were obtained from a large international sample that used regression techniques to transform health-rated BMI cutoffs at 18 yrs of age or older. Youth whose BMI corresponding to the adult value of ≥25 were classified as overweight (including both overweight and obese), while those whose BMI corresponded to an adult BMI of ≥30 were classified as obese.

Individual Covariates

Individual-level confounders included age and sex. Because physical activity is associated with lower levels of overweight and obesity (25), it was also considered as a potential confounder in the analysis. Students were asked how many days per typical week they were physically active for at least 60 minutes. They were given 8 options ranging from 0-7 days per week. The Family Affluence Scale, a measure of family wealth developed for use in the HBSC (26), was also included as a covariate. This scale is based on 4 questions regarding material wealth (car ownership, bedroom sharing, holiday travel, and computer
ownership). Individual-level SES was considered as a potential confounder in the analysis because of its association with obesity (27, 28) and access to food retailers (22, 29-31).

**Statistical Analysis**

A Spearman’s correlation matrix was created to estimate the strength of the relationship between the number of individual food retailers and the total food retailer index for the neighbourhoods of the participating schools for both the 1 km and 5 km distances.

The regression analyses were performed using multilevel modeling to take into account the clustered nature of the data and to allows for simultaneous consideration of both individual-level and area-level variables (32). The Hierarchical Linear Modeling (HLM) software package, version 5.05 (Scientific Software International, Lincolnwood, IL) was used to perform multilevel logistic regression. Overweight (including both overweight and obese youth) was the binary outcome considered in the logistic models.

A three step modeling process was used. Initially, each covariate was examined bivariately with the outcome variables. At this stage, the individual-level variables were assessed to determine whether there were complex level 2 effects, whereby the relationship between individual-level variables and overweight differed across schools. This was achieved by treating each individual-level covariate randomly and analyzing their slopes across schools. The HLM software package provided a statistic to determine whether there were statistically significant differences in the slopes across schools. Since no complex level 2 effects were found and the effects of individual level variables were treated as fixed across all schools. Thus, all models in the analysis were random intercept models, where only area-level variables were allowed to vary randomly.
The second phase of the modeling process involved the creation of multivariate models. Covariates that were significantly related to the outcome variable (p-value < 0.05) in the bivariate analysis were considered in the multivariate models, which were created using a manual stepwise approach. For the 1 km analysis, the variables were added in order starting with the lowest p-value. Because dummy variables were used in the 5 km analysis for the food retailer exposure groups, the average p-value for each food retailer was used to determine the order of entry into the model. The third phase of the modeling process involved the addition of a variable for the exposure to the total food retailer index to determine if the combined effect of the food retailers was more strongly predictive of overweight and obesity than each retailer individually. Due to problems in converging multilevel models with several area-level variables included, the food retailers were not included, forced, or retained in the stepwise multivariate models unless they were statistically significant.

**Calculation of Statistical Power**

Multilevel modeling does not allow for the calculation of statistical power through conventional equations used with standard multivariate regression since observations may be clustered within groups. Therefore, a design effect was used to adjust the sample size to account for the clustered nature of the data (33). The sample size for a multilevel design is equal to the sample size that would be required for a simple random sample design, multiplied by the design effect (33). A design effect of 1.4 is associated with the HBSC survey (26), which was then used to obtain a reduced sample size of 5201. This was obtained
by dividing the total available sample size by the design effect. The reduced sample size was then applied to conventional equations used to obtain study power.

This study achieved >90% power to detect a 20% change in the odds ratio for overweight according to food retailer exposure with two exceptions. For total food retailers and full service restaurants at the 5 km distance the power estimates were 78% and 84%, respectively. These calculations assumed that 20% of the student population was overweight as reported in a recent HBSC survey (34). The percentage of students exposed to the food retailers was based on the results presented in the first manuscript of this thesis.

RESULTS

A total of 9,672 students from 188 schools participated in the 2005/05 HBSC survey, but due to incomplete information, the analysis was limited to 7,281 (75.2%) students from 178 (94.7%) schools. The number of overweight and obese students is presented in Table 1. Slightly more males than females were overweight or obese. The majority of the participants reported being physically active 5 to 7 days per week. Less than 10% of the participants fell into the lowest Family Affluence Scale category, indicating that most were of medium or high affluence. Of the individual-level variables listed in Table 1, only age was not significantly (p<0.05) associated with overweight and obesity. Thus, all of the individual-level variables, with the exception of age, were included as covariates in the multivariate regression models. Of the area-level covariates, urban-rural status but not area-level SES was related to overweight; therefore, urban-rural status was also included as a covariate in the multivariate regression models.
The correlation matrix showing the relation between the number of the different types of food retailers at both the 1 km and 5 km distances is provided in Table 2. For both distances, the number of the individual food retailers were highly correlated (P<0.001) with one another and the total food retailer index. In general, the number of full-service restaurants was the most highly correlated with the total food retailer index, while the number of convenience stores and fast food restaurants were the least correlated with the other food retailer types and the total food retailer index.

1 km Distance

In the bivariate analyses, each type of food retailer and the total food retailer index were negatively associated (p<0.05) with overweight (Table 3). In the first multivariate model (which did not consider the total food retailer index) fast food restaurants, sub/sandwich shops, and donut/coffee shops were included. Youth who had access to these types of food retailers within 1 km of their school were less likely to be overweight compared to youth who did not have access to these types of food retailers within 1 km of their school (Table 3). When the total number of food retailers was considered in a second multivariate model, the individual food retailer types no longer met the inclusion criteria to be included in the model. However, the students whose schools were above the median for the total food retailer index had a reduced likelihood of being overweight compared to the students whose schools were below the median for the total food retailer index (Table 3).
5 km Distance

In the bivariate analyses, at least one of the non-referent exposure categories (low, moderate, or high) for each type of food retailer and the total food retailer index was associated (p<0.05) with a decreased likelihood of overweight (Table 4). The results for the bivariate analyses at the 5 km distance were consistent whether the total number of food retailers or the population density of food retailers (number per 10,000 people) was examined.

When the initial multivariate model was fit for the number of food retailers at the 5 km distance, only full-service restaurants was included in the model (Table 4). Compared to those living in neighbourhoods with no full-service restaurants, participants who lived in neighbourhoods with medium and high numbers of full-service restaurants were less likely to be overweight. When the total number of food retailers was considered in a second multivariate model, the individual food retailer types no longer met the inclusion criteria to be included in the model (Table 4).

When the initial multivariate model was fit for the number of restaurants per 10,000 people at the 5 km distance, donut/coffee shops and grocery stores were included in the model such that students living in neighbourhoods with a moderate exposure to these two types of food retailers were less likely to be overweight than students with no exposure. Similar observations were made in the second multivariate model that considered the total food retailer index (Table 4).
**Obesity Outcome**

The analyses for the overweight outcome (which including both overweight and obese youth) presented in Tables 3 and 4 were re-run while considering obesity alone as the outcome. The results were comparable, although the total index of food retailers was not significant at the 0.05 level of significance. There were some slight variations in the types of food retailers that were included in the multivariate models.

**DISCUSSION**

The key observation from this study is that increased exposure to food retailers, both in the immediate school environment and in the broader neighbourhood, was associated with a decreased odds of overweight and obesity in Canadian school-aged youth. This relationship was consistent across all food retailer types. The direction of the association remained unchanged when other individual and area-level covariates were accounted for.

Findings of this study were inconsistent with the *a priori* hypothesis that exposure to certain types of food retailers (fast food, donut/coffee shops, convenience stores) would be associated with an increased relative odds of overweight and obesity. Furthermore, the findings also contradict what has been reported in the previous literature on the relationship between measures of adiposity and food retailers. A study by Maddock (13) found that a high density of fast food restaurants was associated with a higher prevalence of obesity throughout the U.S., while our study found the opposite relationship. Morland et al. (14) found that grocery stores and convenience stores were associated with a high prevalence of adult obesity, while supermarkets associated with a low prevalence of adult obesity. Our inability to differentiate between grocery stores, supermarkets, and ethnic markets may have contributed to the discrepancy in findings. However, Wang et al. (31) found that the presence...
of supermarkets was associated with a higher BMI, but in women only. They also found that
the presence of grocery stores and ethnic markets were associated with a higher BMI in
women. Notable SES gradients in exposure to food retailers in the American setting may be a
reflection of larger disparities between high and low SES neighbourhoods. Additionally,
there may be a larger abundance of certain brands of food retailers (i.e., fast food chains)
which do not exist in Canada that may be driving these differences.

Although our findings are dissimilar to most existing analogous research, they were
consistent across distance, whether food retailers were considered together or separately, and
also after taking population density into account (5 km radius), making it unlikely that they
are spurious results. Thus, having access to a variety of food retailers may be beneficial
because it allows for a broad variety of choices rather than being forced to rely on a limited
selection of options. It may not be the type of food retailer that is important per se, but the
opportunity to select healthier choices that may explain the protective effect of food retailers
against overweight and obesity.

It is possible that the number of food retailers may be capturing the effect of more
complex features of the environment. Other aspects of the environment such as the
availability of recreational facilities (35, 36) and nearby parks (35, 37, 38) are associated
with the frequency of physical activity and BMI in youth. Thus, the presence of food retailers
may also be correlated with the presence of facilities that promote physical activity, which
could explain the lower levels of overweight and obesity in schools that are close to various
food retailers. It is also possible that the relationship between having access to food retailers
and purchasing food from them is not straightforward. Students may have access to the food
retailers, but there may be other unknown factors determining whether students choose to
purchase food available to them. For example, the distinction between chain and non-chain 
may be important to youth, who may be more likely to purchase foods marketed by large 
chain retailers. Also, over time people may become accustomed to the food retailers within 
their environment and become less likely to frequent them.

This study has several limitations. First, we were unable to take into account internal 
sources of food within the schools, such as vending machines and cafeterias, as these were 
not available in the HBSC survey. These food sources may have been particularly important 
for rural schools, which have less access to external food retailers, and urban school with 
policies on leaving school grounds during the school day. Second, because the students’ 
addresses were not collected in the survey, the 5 km radius surrounding each school was used 
as a proxy for the neighbourhoods of the students attending that school. Some of the students 
lived outside this area, and the access to the food environment within 5 km of their home 
may have differed significantly from that of their school.

Two additional limitations warrant discussion. The lack of questions regarding food 
purchasing and consumption behaviours, we are unable to make the assumption that the 
presence of food retailers is associated with the consumption of the food they sell. 
Conclusions can only be made about the availability of the food retailers and measures of 
adiposity, rather than individual-level behaviours that may also be associated with negative 
health outcomes. Further studies are needed to identify factors associated with purchasing 
behavior or other health outcomes such as unhealthy eating patterns. Also, we were only 
considering half of the energy balance equation. Environmental factors influencing physical 
activity levels have not been considered in this study and should be a topic of future research. 
Finally, because the heights and weights used to calculate BMI status were obtained through
self-report, they may have resulted in some non-differential misclassification bias that could have decreased the magnitude of the relationship between overweight/obesity and exposure to food retailers.

There are also several notable strengths and unique aspects of this study. This is the first study to examine the effect of the food retail environment on obesity in Canadian youth. This is an important population to study because they are in a transition period in their lives where they are becoming more autonomous in the decisions they make. Therefore, understanding the mechanisms of how the environment influences their decisions has important implications in the study of obesity. The use of a multilevel modeling strategy is a valuable tool in achieving this goal because it examined the effect of the environment, after accounting for individual level factors related to overweight and obesity. Furthermore, we were able to examine this relationship on a national scale, allowing the results to be applied to more than one region.

The results of this study revealed that the effect of the environment on overweight and obesity is complex. It appears that the effect of food environment on overweight in obesity in youth is notably different than what has been found in American studies. According to our results, policy interventions limiting the number and type of food retailers within the school environment may not be an effective strategy for the prevention and reduction of overweight and obesity in youth. Future research is needed to provide a greater understanding of the mechanisms behind this relationship as well as other environmental determinants of overweight and obesity.
References


Table 1. Individual-level demographic characteristics of study participants

<table>
<thead>
<tr>
<th></th>
<th>Number</th>
<th>Percent (S.E.)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Sex</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Males</td>
<td>3 878</td>
<td>48.6 (0.6)</td>
</tr>
<tr>
<td>Females</td>
<td>4 109</td>
<td>51.5 (0.6)</td>
</tr>
<tr>
<td><strong>Age (years)</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>≤11</td>
<td>777</td>
<td>9.7 (0.3)</td>
</tr>
<tr>
<td>12</td>
<td>1 204</td>
<td>15.1 (0.4)</td>
</tr>
<tr>
<td>13</td>
<td>1 491</td>
<td>18.7 (0.4)</td>
</tr>
<tr>
<td>14</td>
<td>1 897</td>
<td>23.8 (0.5)</td>
</tr>
<tr>
<td>15</td>
<td>1 894</td>
<td>23.7 (0.5)</td>
</tr>
<tr>
<td>≥16</td>
<td>724</td>
<td>9.1 (0.3)</td>
</tr>
<tr>
<td><strong>Body Mass Index (kg/m²)</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Normal weight</td>
<td>6 251</td>
<td>78.3 (0.5)</td>
</tr>
<tr>
<td>Overweight (non-obese)</td>
<td>1 278</td>
<td>16.0 (0.4)</td>
</tr>
<tr>
<td>Obese</td>
<td>458</td>
<td>5.7 (0.3)</td>
</tr>
<tr>
<td><strong>Physical Activity (d/wk active for ≥60 min)</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0</td>
<td>156</td>
<td>2.0 (0.2)</td>
</tr>
<tr>
<td>1</td>
<td>396</td>
<td>5.0 (0.2)</td>
</tr>
<tr>
<td>2</td>
<td>743</td>
<td>9.4 (0.3)</td>
</tr>
<tr>
<td>3</td>
<td>1 099</td>
<td>13.9 (0.4)</td>
</tr>
<tr>
<td>4</td>
<td>1 168</td>
<td>14.7 (0.4)</td>
</tr>
<tr>
<td>5</td>
<td>1 576</td>
<td>19.9 (0.4)</td>
</tr>
<tr>
<td>6</td>
<td>1 258</td>
<td>15.9 (0.4)</td>
</tr>
<tr>
<td>7</td>
<td>1 539</td>
<td>19.4 (0.4)</td>
</tr>
<tr>
<td><strong>Family Affluence Scale</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1 (Least Affluent)</td>
<td>905</td>
<td>11.3 (0.4)</td>
</tr>
<tr>
<td>2</td>
<td>2 991</td>
<td>37.5 (0.5)</td>
</tr>
<tr>
<td>3 (Most Affluent)</td>
<td>4 091</td>
<td>51.2 (0.6)</td>
</tr>
</tbody>
</table>
Table 2. Correlation between the number of different food retailer types surrounding the 178 schools at 1 km and 5 km distances.

<table>
<thead>
<tr>
<th></th>
<th>Full-Service Restaurants</th>
<th>Fast Food Restaurants</th>
<th>Sub/Sandwich Shops</th>
<th>Donut/Coffee Shops</th>
<th>Convenience Stores</th>
<th>Grocery Stores</th>
<th>Total Food Retailer Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full-Service Restaurants</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fast Food Restaurants</td>
<td>0.64</td>
<td></td>
<td>0.90</td>
<td>0.90</td>
<td>0.79</td>
<td>0.83</td>
<td>0.91</td>
</tr>
<tr>
<td>Sub/Sandwich Shops</td>
<td>0.63</td>
<td>0.53</td>
<td>0.91</td>
<td>0.83</td>
<td>0.86</td>
<td>0.93</td>
<td></td>
</tr>
<tr>
<td>Donut/Coffee Shops</td>
<td>0.63</td>
<td>0.50</td>
<td>0.55</td>
<td></td>
<td>0.84</td>
<td>0.91</td>
<td>0.95</td>
</tr>
<tr>
<td>Convenience Stores</td>
<td>0.73</td>
<td>0.41</td>
<td>0.47</td>
<td>0.53</td>
<td></td>
<td>0.83</td>
<td>0.90</td>
</tr>
<tr>
<td>Grocery Stores</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td></td>
<td>0.93</td>
</tr>
<tr>
<td>Total Food Retailer Index</td>
<td>0.97</td>
<td>0.67</td>
<td>0.65</td>
<td>0.68</td>
<td>0.81</td>
<td></td>
<td>--</td>
</tr>
</tbody>
</table>

Correlations for the 1 km radius are shown in the bottom half of the correlation matrix while correlations for the 5 km radius are shown in *italics font* in the top half of the correlation matrix. All correlations were statistically significant at p<0.0001.
Table 3. Association between exposure to different types of food retailers within 1 km of schools and overweight

<table>
<thead>
<tr>
<th></th>
<th>Bivariate Analyses</th>
<th>Multivariate Analyses (Model 1)*</th>
<th>Multivariate Analyses (Model 2)*</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Full Service Restaurants</td>
<td>0.81 (0.69-0.94) ‡</td>
<td>--</td>
<td>--</td>
</tr>
<tr>
<td>Fast Food Restaurants</td>
<td>0.70 (0.58-0.81) ‡</td>
<td>0.83 (0.70-0.98) †</td>
<td>--</td>
</tr>
<tr>
<td>Sub/Sandwich Shops</td>
<td>0.65 (0.56-0.76) ‡</td>
<td>0.78 (0.64-0.93) ‡</td>
<td>--</td>
</tr>
<tr>
<td>Donut/Coffee Shops</td>
<td>0.68 (0.59-0.78) ‡</td>
<td>0.81 (0.68-0.96) †</td>
<td>--</td>
</tr>
<tr>
<td>Convenience Stores</td>
<td>0.79 (0.69-0.92) ‡</td>
<td>--</td>
<td>--</td>
</tr>
<tr>
<td>Total Food Retailer Index</td>
<td>0.69 (0.06-0.79) ‡</td>
<td>N/A</td>
<td>0.70 (0.61-0.81) ‡</td>
</tr>
</tbody>
</table>

Data presented as odds ratios (95% confidence intervals). For the individual food retailers the ‘no’ (0 retailers) exposure group served as the referent category while for the total food retailer index the group falling below the median served as the referent category.

* The multivariate models were adjusted for sex, physical activity, and family affluence. The total food retailer index was considered in Model 2 but not in Model 1.

† = significant at p<0.05
‡ = significant at p<0.01
‘--’ = not included in the final model
Table 4. Association between exposure to different types of food retailers within 5 km of schools and overweight

<table>
<thead>
<tr>
<th>Food Retailer Type</th>
<th>Model*</th>
<th>Number of food retailers within 5 km</th>
<th>Number of food retailers per 10,000 people within 5 km</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Low  Medium  High  Low  Medium  High</td>
<td>Low  Medium  High  Low  Medium  High  Low  Medium  High</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Model* 1  2</td>
<td>1  2</td>
</tr>
<tr>
<td>Full-Service</td>
<td>Bivariate</td>
<td>0.81 (0.70-1.00)  0.74 (0.59-0.92) ‡</td>
<td>0.52 (0.42-0.66) ‡</td>
</tr>
<tr>
<td></td>
<td>Multivariate 1</td>
<td>0.79 (0.63-1.00)  0.74 (0.58-0.93) †</td>
<td>0.50 (0.40-0.64) ‡</td>
</tr>
<tr>
<td></td>
<td>Multivariate 2</td>
<td>--  --</td>
<td>--</td>
</tr>
<tr>
<td>Fast Food</td>
<td>Bivariate</td>
<td>0.87 (0.72-1.05)  0.73 (0.60-0.88) ‡</td>
<td>0.70 (0.58-0.85) ‡</td>
</tr>
<tr>
<td></td>
<td>Multivariate 1</td>
<td>--  --</td>
<td>--</td>
</tr>
<tr>
<td></td>
<td>Multivariate 2</td>
<td>--  --</td>
<td>--</td>
</tr>
<tr>
<td>Sub/Sandwich</td>
<td>Bivariate</td>
<td>0.90 (0.75-1.07)  0.70 (0.57-0.85) ‡</td>
<td>0.66 (0.55-0.79) ‡</td>
</tr>
<tr>
<td></td>
<td>Multivariate 1</td>
<td>--  --</td>
<td>--</td>
</tr>
<tr>
<td></td>
<td>Multivariate 2</td>
<td>--  --</td>
<td>--</td>
</tr>
<tr>
<td>Donut/Coffee</td>
<td>Bivariate</td>
<td>0.79 (0.66-0.95) †  0.68 (0.56-0.82) ‡</td>
<td>0.60 (0.50-0.72) ‡</td>
</tr>
<tr>
<td></td>
<td>Multivariate 1</td>
<td>--  --</td>
<td>--</td>
</tr>
<tr>
<td></td>
<td>Multivariate 2</td>
<td>--  --</td>
<td>--</td>
</tr>
<tr>
<td>Convenience</td>
<td>Bivariate</td>
<td>0.97 (0.80-1.18)  0.81 (0.70-0.98) †</td>
<td>0.61 (0.50-0.75) ‡</td>
</tr>
<tr>
<td></td>
<td>Multivariate 1</td>
<td>--  --</td>
<td>--</td>
</tr>
<tr>
<td></td>
<td>Multivariate 2</td>
<td>--  --</td>
<td>--</td>
</tr>
<tr>
<td>Grocery</td>
<td>Bivariate</td>
<td>0.86 (0.72-1.02)  0.84 (0.69-1.01)</td>
<td>0.55 (0.46-0.67) ‡</td>
</tr>
<tr>
<td></td>
<td>Multivariate 1</td>
<td>--  --</td>
<td>--</td>
</tr>
<tr>
<td></td>
<td>Multivariate 2</td>
<td>--  --</td>
<td>--</td>
</tr>
<tr>
<td>Total Food</td>
<td>Bivariate</td>
<td>0.84 (0.70-1.01)  0.80 (0.67-0.96) †</td>
<td>0.56 (0.47-0.68) ‡</td>
</tr>
<tr>
<td>Retailer Index</td>
<td>Multivariate 1</td>
<td>N/A  N/A</td>
<td>N/A</td>
</tr>
<tr>
<td></td>
<td>Multivariate 2</td>
<td>0.82 (0.68-0.99) †  0.79 (0.66-0.95) †</td>
<td>0.53 (0.43-0.64) ‡</td>
</tr>
</tbody>
</table>

Data presented as odds ratios (95% confidence intervals). For the individual food retailers the ‘no’ (0 retailers) exposure group served as the referent category while for the total food retailer index the group falling below the median served as the referent category.

* The multivariate models were adjusted for sex, physical activity, and family affluence. The total food retailer index was considered in Model 2 but not in Model 1.
N/S = non-significant
† = significant at p<0.05
‡ = significant at p<0.01
‘--’ = not included in the final model

81
CHAPTER 6: GENERAL DISCUSSION

6.1 Bridging the Two Manuscripts – A Summary of Key Findings

The overall purpose of this thesis was to describe and analyze the impact of the food environment surrounding schools in Canada. The results from the first manuscript revealed that, after consideration of population density, neighbourhood SES had a minimal impact on the number and type of food retailers both within close proximity of schools (1 km) and within the broader neighbourhood (5 km) in which students live. This finding implies that Canadian schools have unique food retail environments that do not differ substantially according to SES; a finding which is contrary to that reported in other countries (1-5). Thus, Canadian youth living in and/or attending schools in poor neighbourhoods are not at a distinct disadvantage in terms of low exposure to healthy food retailers and high exposure to unhealthy food retailers.

The second manuscript explored the impact of food retailers surrounding schools on the prevalence of overweight and obesity in the youth attending those schools, after accounting for other important covariates at both the individual- and area-level. Results indicated that exposure to different types of food retailers was associated with a decreased likelihood of overweight and obesity, a finding that was consistent for both the 1 km and 5 km distances. Furthermore, when total food retailer indices were incorporated into the analysis, their combined effect was also significant. The consistent protective effect of the various types of food retailers, coupled with the high correlation between the number of the different types of food retailers in the school neighbourhoods, suggests that having a large selection of food retailers may be more important than the type of food retailers themselves.
That is, have a large number and variety of food retailers may facilitate the purchase and consumption of healthy foods, thereby lowering the risk of overweight and obesity.

6.2 Limitations of the Thesis

There are several limitations of this thesis that warrant discussion. 1) While some consideration was given to physical activity in the second manuscript, the emphasis of this thesis was predominantly on the food environment, which represents only one side of the energy balance equation. It is possible that the inclusion of features of the environment that encourage or inhibit physical activity as covariates in the analyses would have modified the results of this thesis. 2) A second limitation is that consideration was only given to accessibility of students to food retailers, rather than the purchase and consumption of foods from these retailers. Because the analysis of the individual data was limited to what was collected in the HBSC survey, we were unable to verify that access to food retailers was associated with food purchasing and consumption behaviours. 3) The assessment of food sources available at school was incomplete due to the lack of information on sources such as vending machines and cafeterias. 4) No standard system exists for the classification of food retailers. Categories listed in the internet-based classification system used in this thesis required modification to meet the objectives of the study, which may have resulted in the misclassification of food retailers. 5) Finally, because the HBSC did not collect information on students’ home addresses, a 5 km radius surrounding schools was chosen as a proxy for the school neighbourhood. Some of the students would have lived outside this distance, and for these students the food retail environment within 5 km of their school may not have accurately captured the food environment of their home neighbourhood. The use of the 1 km
and 5 km radii to determine the distance to nearby food retailers is a second limitation. Characteristics of street network (i.e., type of street, road layout, intersection density, and structures such as bridges or crosswalks) have an influence on the distance traveled and the time to travel a given distance. Sophisticated measures of street layout that take street network into account were not feasible for this study.

6.3 Strengths of the Thesis

This is the first study to investigate the role and potential effect of the food environment on overweight and obesity in school-aged youth in Canada. Youth attending the upper years of elementary school and high school are vastly underrepresented in the existing body of literature that examines this food environment. However, adolescents are an important segment of the population to study because they are becoming autonomous in the choices they make, which may have important health-related implications. The availability of food retailers may affect adolescents differently than preschoolers or adults.

This thesis also contributes to the literature by providing additional perspective about the effect of specific food environments within Canada. The value of this perspective emerged when the results were compared with U.S.-based studies of neighbourhood SES on food retailer accessibility. These U.S. studies had entirely different conclusions (2, 3, 5). The use of multilevel modeling was advantageous because it allowed the simultaneous consideration of both individual- and area-level covariates, whereas some previous ecological approaches were unable to do so. Finally, having a large sample size with representation with respect to geographic region, socioeconomic status, urban-rural status,
and public and separate school boards suggests that the results of this study were more widely generalizable than many of the previous studies in this area.

### 6.4 Public Health and Policy Implications

This study provides evidence that exposures to food retailers exert a unique influence on Canadian youth. With respect to the first manuscript, the food environment does not appear to be subject to the same trends in exposure by SES as observed in previous studies. Development of policies governing the number, type, and location of food retailers in close proximity to schools do not need to be undertaken to address neighbourhood inequalities in food retailer access and obesogenic behaviours. However, schools may wish to either consider limiting student access to local food retailers due to the abundance of retailers within walking distance of schools. More realistically, schools may want to implement interventions promoting healthy choices from the selection of food retailers in the vicinity of the school environment.

Analyses in the second manuscript did not find an association between access to ‘unhealthy’ food retailers, such as fast food restaurants and convenience stores, and increased likelihood of overweight and obesity in youth. This finding was surprising and suggests that the initiation of policies limiting the number and type of these food retailers surrounding schools will not appreciably reduce overweight and obesity levels in Canadian youth. If anything, findings from the second manuscript suggest that having a large number and variety of food retailers may lower the risk of overweight and obesity. An increase in food options perhaps facilitates the purchase and consumption of healthy, low caloric foods.
6.5 Future Research Directions

Because the study of the food environment is a newly emerging area of obesity research, formal evaluation of policies designed to regulate the food environment are lacking. Some jurisdictions within the U.S. are currently considering policies that limit the number and type of certain types of food retailers such as fast food restaurants and encourage the establishment of supermarkets and farmer’s markets in order to facilitate healthy nutritional choices through modifying the food environment (6, 7). These strategies are in the early proposal stage and formal evaluations of their effectiveness in improving diet and lowering obesity rates have not been carried out. Other important areas for future research include investigation of the relationships between built environments on physical activity and rates of obesity among youth. Parks and recreational facilities within neighbourhoods may also be an important influence on physical activity and obesity in youth. Given the paucity of research in these areas, future study is required to achieve a more complete understanding of how other aspects of the environment may influence overweight and obesity in youth living in Canada and elsewhere.
References


## APPENDIX A. FOOD RETAILER CATEGORIES

<table>
<thead>
<tr>
<th>Original Category</th>
<th>Modified Category</th>
</tr>
</thead>
<tbody>
<tr>
<td>Restaurant</td>
<td>Full Service Restaurant</td>
</tr>
<tr>
<td>Fast Food</td>
<td>Fast Food Restaurant</td>
</tr>
<tr>
<td>Hamburger</td>
<td>Fast Food Restaurant</td>
</tr>
<tr>
<td>Pizza</td>
<td>Sub/Sandwich Shop</td>
</tr>
<tr>
<td>Sandwich</td>
<td>Sub/Sandwich Shop</td>
</tr>
<tr>
<td>Delicatessen</td>
<td>Sub/Sandwich Shop</td>
</tr>
<tr>
<td>Submarine Sandwich</td>
<td></td>
</tr>
<tr>
<td>Coffee</td>
<td>Donut/Coffee Shop</td>
</tr>
<tr>
<td>Donut</td>
<td></td>
</tr>
<tr>
<td>Convenience Store</td>
<td>Convenience Store</td>
</tr>
<tr>
<td>Variety Store</td>
<td></td>
</tr>
<tr>
<td>Grocery Store</td>
<td>Grocery Store</td>
</tr>
</tbody>
</table>

88
APPENDIX B: SORTING FOOD RETAILERS

Sorting Instructions: Part 1

Total Fast Food:

1. Create a new worksheet (Insert ➔ Worksheet) at the end of the existing worksheets called Total F.
2. Copy and paste the existing Fast Food retailers into the new worksheet.
3. Create new columns beside Distance called Fast Food, Pizza, Hamburger and Restaurant, and copy and paste respective food retailers into the Total F worksheet. Put a “y” in the appropriate category indicating where you got the retailers from.
4. Go to the Restaurant category and highlight all the food retailers. Go to Data ➔ Sort ➔ by Name. Cut chain retailers (see attached table) and paste them in the Total F category and put a “y” in the Restaurant column. To remove blank entries from the Restaurant worksheet, perform another sort by Name.
5. Highlight the data in the Total F page and go to Data ➔ Sort. Sort by Address then “Name”.
6. Cut duplicate records and paste at the bottom of spreadsheet page. To remove blank entries in the spread sheet, perform another sort by Name and Address.

Total Sandwich/Deli:

1. Create a new worksheet (Insert ➔ Worksheet) at the end of the existing worksheets called Total S.
2. Copy and paste the existing Sandwich retailers into the new worksheet.
3. Create new columns beside Distance called Sandwich, Deli, Submarine and Restaurant, and copy and paste respective food retailers into the Total S worksheet. Put a “y” in the appropriate category indicating where you got the retailers from.
4. Cut chain retailers (see attached table) from the Restaurant category and paste them in the Total S category and put a “y” in the Restaurant column. To remove blank entries from the Restaurant worksheet, perform another sort by Name.
5. Highlight the data in the Total S page and go to Data ➔ Sort. Sort by Address then Name.
6. Cut duplicate records and paste at the bottom of spreadsheet page. To remove blank entries in the spread sheet, perform another sort by Name and Address.

Total Donut/Coffee:

1. Create a new worksheet (Insert ➔ Worksheet) at the end of the existing worksheets called “Total D”.
2. Copy and paste the existing Donut retailers into the new worksheet.
3. Create new columns beside Distance called Donut, Coffee and Restaurant. Copy and paste respective food retailers into the Total D worksheet. Put a “y” in the appropriate category indicating where you got the retailers from.
4. Cut chain retailers (see attached table) and paste them in the Total D category and put a “y” in the Restaurant column. To remove blank entries from the Restaurant worksheet, perform another sort by Name.

5. Highlight the data in the Total S page and go to Data → Sort. Sort by Address then Name.

6. Cut duplicate records and paste at the bottom of spreadsheet page. To remove blank entries in the spread sheet, perform another sort by Name and Address.

**Total Variety/Convenience & Total Grocery Store:**

1. Create a new worksheet (Insert → Worksheet) at the end of the existing worksheets called Total V.

2. Create new columns beside Distance called Convenience, Variety and Grocery. Copy and paste the existing Convenience and Variety store retailers into the new worksheet. Put a “y” in that column indicating that you obtained these from the original donut category.

3. Create a new worksheet for Grocery called Total G.

4. Copy and paste data from original Grocery stores list into Total G. Sort total G by Name.

5. Cut chain retailers (see attached table) from the Total G worksheet and paste them in the Total V worksheet. Put a “y” in the corresponding column.

6. Highlight the data in the Total V worksheet and go to Data → Sort. Sort by Address then Name.

7. Cut and paste duplicate records at bottom of spreadsheet page.

8. Sort Total G worksheet by Address then Name. Cut duplicates and paste at the bottom of the page.
### Food Retailer Table

<table>
<thead>
<tr>
<th>Fast Food</th>
<th>Sandwich</th>
<th>Coffee shops</th>
<th>Convenience Stores</th>
</tr>
</thead>
<tbody>
<tr>
<td>A&amp;W</td>
<td>Mr. Sub</td>
<td>Coffee Time</td>
<td>7-Eleven</td>
</tr>
<tr>
<td>Arby’s</td>
<td>Pita Pit</td>
<td>Country Style</td>
<td>Mac’s</td>
</tr>
<tr>
<td>Burger King</td>
<td>Quizno’s</td>
<td>Dunkin’ Donuts</td>
<td>Daisy Mart</td>
</tr>
<tr>
<td>Dairy Queen</td>
<td>Subway</td>
<td>Krispy Kreme</td>
<td>Hasty Market</td>
</tr>
<tr>
<td>Domino’s</td>
<td></td>
<td>Second Cup</td>
<td></td>
</tr>
<tr>
<td>Harvey’s</td>
<td></td>
<td>Starbucks</td>
<td></td>
</tr>
<tr>
<td>Kentucky Fried Chicken</td>
<td></td>
<td>Tim Horton’s</td>
<td></td>
</tr>
<tr>
<td>Little Caesar’s</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>McDonald’s</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>New Orlean’s Pizza</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>New York Fries</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pizza Pizza</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pizza Nova</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Taco Bell</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Wendy’s</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>241 Pizza</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Sorting Instructions: Part 2

1. Rename the Restaurant Worksheet as ALL. Add 6 new columns: Restaurant, Fast Food, Sandwich, Donut, Variety & Grocery.

2. Put a ‘y’ in the Restaurant column for each restaurant.

3. Copy & Paste data from Total F, Total S, Total D, Total V & Total G worksheets. Put a ‘y’ in their corresponding columns.

4. Select all food retailers. Sort by Address and then Name.

5. For duplicate records involving Restaurant and Fast food, Sandwich or Donut, keep the entry classified under the Restaurant category. Delete the other record(s).

6. To re-categorize food retailer into types, do a sort by Restaurant, then Fast Food, then Sandwich. After the final Sandwich retailer, select remaining retailers and perform a search by Column I (Donut), then Column J (Variety), and then Column K (Grocery).

7. For grocery stores that have ‘Convenience’, ‘Variety’, ‘Milk’, ‘Mini Mart’, ‘Video’ or ‘Gas’ in their name, reclassify as Variety Store.

Delete any implausible entries (i.e. location too far, not a food retailer)
**APPENDIX C**: The relationship between exposure to food retailers and SES gradient

<table>
<thead>
<tr>
<th>Category</th>
<th>Number of retailers within 1 km</th>
<th>Number of retailers within 5 km</th>
<th>Number of retailers per 10,000 people within 5 km</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Jonckheere-Terpstra z-statistic</td>
<td>2-sided p-value</td>
<td>Jonckheere-Terpstra z-statistic</td>
</tr>
<tr>
<td>Restaurant</td>
<td>2.4779</td>
<td>0.0132*</td>
<td>3.5702</td>
</tr>
<tr>
<td>Fast Food</td>
<td>0.5744</td>
<td>0.5657</td>
<td>3.1988</td>
</tr>
<tr>
<td>Sandwich</td>
<td>0.9874</td>
<td>0.3235</td>
<td>3.5050</td>
</tr>
<tr>
<td>Donut/Coffee</td>
<td>0.9341</td>
<td>0.3503</td>
<td>3.5272</td>
</tr>
<tr>
<td>Convenience</td>
<td>1.2600</td>
<td>0.2077</td>
<td>2.2609</td>
</tr>
<tr>
<td>Grocery</td>
<td>--</td>
<td>--</td>
<td>2.9642</td>
</tr>
</tbody>
</table>

A positive Jonckheere-Terpstra z-score statistic indicates an increasing trend in exposure to food retailers across SES categories, with low SES having the least access. Conversely, a negative z-score indicates a decreasing trend in exposure to food retailers, with low SES having the most access.

† significant at p<0.01
* significant at p<0.05
APPENDIX D: ETHICS APPROVAL

November 27, 2006

Ms. Laura Seliske
Department of Community Health & Epidemiology
Queen's University

Re: "The influence of food retailers on obesity and unhealthy eating in Canadian school-aged youth: a multilevel analysis"

Dear Ms. Seliske,

I am writing to acknowledge receipt of your recent ethics submission for the above-named study. I have reviewed the materials and do not feel that it is necessary for the study to undergo a full REB review. I have therefore given the study an expedited review and an approval sheet is appended for your records. This study will be reported to the Research Ethics Board.

Yours sincerely,

Albert Clark, Ph.D.
Chair
Research Ethics Board

AFC/kr

c.c.: Dr. Ian Janssen, Department of Community Health and Epidemiology
      Dr. William Pickett, Department of Community Health and Epidemiology

think Research
think Queen's
QUEEN'S UNIVERSITY HEALTH SCIENCES & AFFILIATED TEACHING HOSPITALS RESEARCH ETHICS BOARD

Queen's University, in accordance with the "Tri-Council Policy Statement, 1998" prepared by the Medical Research Council, Natural Sciences and Engineering Research Council of Canada and Social Sciences and Humanities Research Council of Canada requires that research projects involving human subjects be reviewed annually to determine their acceptability on ethical grounds.

A Research Ethics Board composed of:

Dr. A.F. Clark  Emeritus Professor, Department of Biochemistry, Faculty of Health Sciences, Queen's University (Chair)

Dr. S. Burke  Emeritus Professor, School of Nursing, Queen's University

Rev. T. Deline  Community Member

Dr. M. Evans  Community Member

Mr. C. Kenny  Community Member

Ms. C. Knott  Research & Evaluation, Southeastern Regional Geriatric Program, Providence Continuing Care Centre – St. Mary's of the Lake Hospital Site

Dr. J. Low  Emeritus Professor, Department of Obstetrics and Gynecology, Queen's University and Kingston General Hospital

Dr. W. Racz  Emeritus Professor, Department of Pharmacology & Toxicology, Queen's

Dr. H. Richardson  Assistant Professor, Department of Community Health & Epidemiology Project Coordinator, NCIC CTG, Queen's University

Dr. B. Simchison  Assistant Professor, Department of Anesthesiology, Queen's University

Dr. A.N. Singh  WHO Professor in Psychosomatic Medicine and Psychopharmacology Professor of Psychiatry and Pharmacology Chair and Head, Division of Psychopharmacology, Queen's University Director & Chief of Psychiatry, Academic Unit, Quinte Health Care, Belleville General Hospital

Dr. E. Tsai  Assistant Professor, Department of Paediatrics and Office of Bioethics, Queen's University

Ms. K. Weishaum  LL.B. and Adjunct Instructor, Department of Family Medicine (Bioethics)

has examined the protocol for the project entitled "The influence of food retailers on obesity and unhealthy eating in Canadian school-aged youth: a multilevel analysis" as proposed by Ms. Laura Selslak, Dr. Ian Janssen and Dr. William Pickett of the Department of Community Health and Epidemiology at Queen's University and considers it to be ethically acceptable. This approval is valid for one year. If there are any amendments or changes to the protocol affecting the subjects in this study, it is the responsibility of the principal investigator to notify the Research Ethics Board. Any unexpected serious adverse event occurring locally must be reported within 2 working days or earlier if required by the study sponsor. All other serious adverse events must be reported within 15 days after becoming aware of the information."

Chair, Research Ethics Board

Date

Epid-237-06

EX
Project Title: The Influence of Food Retailers on Obesity and Unhealthy Eating in Canadian School Aged Youth: a Multi-level Analysis

1. Human subjects will be required to participate: NO [ ] YES [ ✓ ]

2. The protocol has been submitted for ethics review: NO [ ] YES [ ✓ ]

3. If answer to 1 is “YES” and 2 is “NO”, please explain: ____________________________________________

4. Does this research require the participation of hospital patients? NO [ ] YES [ ✓ ]
   Circle hospital(s) concerned: KGH HDH SMOL KPH Other (specify) ____________

5. Will hospital facilities be required for research involving human subjects? NO [ ] YES [ ] N/A [ ✓ ]
   Circle hospital(s) concerned: KGH HDH SMOL KPH Other (specify) ____________

6. Will patients be selected from department other than your department of primary affiliation?
   If yes, your signature below indicates that you have received written consent from the
   Head(s) of hospital department(s) NO [ ] YES [ ] N/A [ ✓ ]

7. Do all research personnel having contact with patients have appropriate hospital
   Department appointments (i.e. staff, residents, departmental assistants)? NO [ ] YES [ ] N/A [ ✓ ]

8. Will research involve the use of hospital facilities over and above those required
   for normal patient care? NO [ ] YES [ ] N/A [ ✓ ]
   If “YES”, indicate department: Cost Costs confirmed with (name of person)
   Laboratory ____________________________ ____________________________
   Nursing ____________________________ ____________________________
   Pharmacy ____________________________ ____________________________
   Radiology ____________________________ ____________________________
   Other [please specify] ____________________________ ____________________________
   TOTAL ____________________________ ____________________________

Are these costs included in the budget of the grant application? NO [ ] YES [ ] N/A [ ✓ ]
If not, how will they be paid for? ____________________________________________

[Signature] [Date] [Signature] [Date]
Investigator Department Head

Chair, Research Ethics Board